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Introduction to Bria 5

This user guide describes how to use and configure Bria 5. Bria 5 is a softphone from
CounterPath that enables you to make VoIP voice and video calls, send and receive
instant messages, share online status (presence) information, and exchange files.

Who this guide is for:

l System administrators who have purchased Bria 5 from the CounterPath website
and are deploying Bria 5 for use by the staff in an enterprise. The administrator
should be familiar with PBX solutions, telephony and VoIP telephony.

l Service providers who have purchased Bria 5 from CounterPath Sales, without
further customization or engineering changes.

l End users who have purchased Bria 5 from the CounterPath website.

l End users in an enterprise or subscribers of a service provider who has deployed
Bria 5.

Recommended usage of this user guide:

l If you are working in an enterprise and you have a system administrator, it is
assumed that your system administrator has configured Bria 5 on your behalf. You
do not need to read the section on configuration.

l If you are deploying Bria 5 without the help of a system administrator, read
Configuring Bria 5 first, then use the rest of the user guide.

l If you are a system administrator at an enterprise or a service provider, read
Configuring Bria 5. You can deploy Bria 5 either by manually configuring via the
softphone GUI or by using a provisioning server. If you decide to implement remote
provisioning, you also need to read the Provisioning Guide.

CounterPath Corporation 1

Bria 5 User Guide Introduction to Bria 5



Bria 5 Features

Standard enterprise telephone features

l Call display

l Voicemail with message waiting indicator (MWI)

l Speakerphone and mute

l Redial

l Hold

l Do not disturb

l Call history

l Call forward

l Call transfer

l Call record

l Auto answer

l Six-party audio conferencing (hosted locally)

l Six-party video conferencing (hosted locally)

Advanced features and functions

l Video calls with 1080p HD support

l Support for the following languages in addition to English: Simplified Chinese
(Windows only), Dutch (Windows only), French, German, Italian (Windows only),
Japanese, Portuguese, Russian, and Spanish

l IM and presence

l IM conferencing (group chat)

l Corporate chat rooms

l Contact list containing the individual user’s contacts

l Favorites list

l Directory containing names from a shared LDAP directory
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l Windows only: Directory containing names from a shared Microsoft® Active
Directory®

l Windows only: Access to Microsoft Outlook® contacts from within Bria 5

l Mac only: Access to Mac address book contacts from within Bria 5

l Windows only: Microsoft Outlook integration

l File transfer

l Support for DTMF (RFC 2833, SIP INFO or inband DTMF)

l Automatic detection of audio and video devices

l Acoustic echo cancellation, automatic gain control, voice activity detection

l Audio codecs: G.711aLaw, G.711µLaw, G.722, G.729A, G.729B, GSM, Opus,
SILK Narrowband, SILK Wideband, SILK Super-Wideband, Speex Narrowband,
Speex Wideband, Speex Wideband

l Video codecs: H.263, H.263+ (1998), H.264, VP8

l Support for these firewall traversal solutions: STUN, TURN, or ICE

l Windows only: Support for silent network installation on Windows workstations

Requirements

Service requirements

l A VoIP service subscription with a local service provider or ISP in order to make
audio or video calls with Bria 5. Please contact your local service provider to
subscribe.

l An XMPP service subscription for presence and messaging.

Component Requirement

Processor Minimum: Core 2 Duo 2.1 GHz

Recommended: i5/i7 2.4 GHzand above

Memory Minimum: 4GBRAM

Desktop System Requirements

CounterPath Corporation 3

Bria 5 User Guide Introduction to Bria 5



Component Requirement

Recommended: 8 GBRAM and above

Hard DiskSpace 400MB (Install/Upgrade, 200MBoperation)

Operating System MicrosoftWindows7 SP1

MicrosoftWindows8.1 (Desktopmode)

MicrosoftWindows10, including 2-in-1 tablet support (FallCreatorsUpdate or newer required)

macOS10.12 (Sierra)

macOS10.13 (High Sierra)

macOS10.14 (Mojave)

Connection IP network connection (broadband, LAN, wireless); Constant Internet connection

Audio Device Full duplex, 16-bit or USBheadset

Bria 5 supports Windows-based 2-in-1 laptops so you can enjoy using Bria 5 in both
desktop mode and tablet mode. Make sure you enable Settings > Devices > Typing >
Touch Keyboard and select Show the touch keyboard when not in tablet mode and
There’s no keyboard attached.
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Quick start – Setting up Bria 5

This section can help you get started with Bria 5.

Set up Bria 5
Download and install for Windows

Download and install for Mac

Choose your sign in profile

Sign in

or

Set up your SIP account and Set up your XMPP account

Connect your headset

Select Softphone >Preferences >Devices (Windows)

Select Bria 5 >Preferences >Devices (Mac)
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Select Softphone >Account Settings >Add (Windows)

Select Bria 5 >Accounts >Add Account (Mac)

Quick start - Getting to know Bria 5
This section can help learn about Bria 5's user interface.

Get to know Bria 5

Learn the tools of Bria 5
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Quick start – Handling calls
This section can help you handle calls on Bria 5.

Make and accept calls

Make a call

Enter a phone number or the name of a contact .

Answer a call

Accept with video or audio or hang up to reject the call.

Start a conference call

Start a conference

Enter a phone number or the
name of a contact and select
Start Conference Call.

Add participants Merge calls together

Click ... More and chooseMerge Calls.
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Select additional contacts to
add.

Transfer a call

Transfer a call (unattended)

ClickTransfer Call and enter the name or number to which
you're transferring the call.

Transfer a call (attended)

ClickTransfer Call, enter the name or number to which
you're transferring the call, and choose Call First.
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When you have spoken to the recipient, clickTransfer (or X
to cancel).
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Getting started

Bria 5 can be deployed with or without a configuration server. If you are deploying Bria 5
with the help of a system administrator, follow the instructions given by the administrator.

To launch Bria 5

1. Obtain the Bria 5 download file and follow the prompts in the install wizard.

Your system administrator may have installed Bria 5 for you using a silent install.

2. Start Bria 5 as you would any other program. The Bria 5 Sign In dialog appears.

3. Set the profile.

l I will manually input my account configuration: Choose this if you have no
login information or configuration server. Configure a SIP account as
described in SIP account requirements.

l Enter Configuration Server details: Choose this option if you have a login
server address and login credentials from your system administrator. Bria 5
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will be automatically configured for you.

4. Click Sign In.

Bria 5 launches. If you chose manual configuration, you are now ready to add accounts.

Switching to configuration server details
If you accidentally selected manual configuration but you should have selected
configuration server details, you can re-enable the sign in screen.

To switch to configuration server details – Windows

1. Open Softphone > Preferences > Application and select Enable Sign In screen.

2. Click OK.

3. Click Sign out in the Softphone menu or exit Bria 5.

4. The next time you sign on to Bria 5 select Enter Configuration Server details and
enter your log in credentials.

Bria 5 launches with your accounts configured.

To switch to configuration server details – Mac

1. Open Bria 5 > Preferences > Application and select Enable Sign In screen.

2. Close Preferences.

3. Click Bria 5 > Sign Out or exit Bria 5.

4. The next time you sign on to Bria 5 select Enter Configuration Server details and
enter your log in credentials.
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Bria 5 launches with your accounts configured.

For more information, see Preferences: Application panel.

Giving permissions to Bria 5 (Mac)
On Mac, Bria 5 asks permissions for:

l Notifications for incoming calls and messages. See Configuring OS notifications.

l Contacts for displaying your contact list within Bria 5

l Microphone for phone conversations

l Camera for video calls

Allow Bria 5 a permission if a pop-up appears. Or change permissions by following the
steps below.

To give permissions to Bria 5

1. Click the Apple icon on the Bria 5 menu and click System Preferences >
Security and Privacy.

2. Click Privacy.

3. Click Contacts in the list, and select Bria 5 to allow access.

4. Repeat Step 3 for Microphone and Camera if applicable.

Exiting Bria 5
When you are ready to stop using Bria 5, you need to exit Bria 5. If you simply close the
Bria 5 on screen phone, Bria 5 continues to run in the background.

To exit Bria 5 - Windows

1. Click Exit on the Softphone menu or type CTRL+Q.

To exit Bria 5 - Mac

1. Click Quit Bria 5 on the Bria 5 menu or type COMMAND+Q.
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Setting up accounts
If you selected manual configuration on the Bria 5 Sign In screen, you need to set up
your accounts.

Bria 5 supports SIP accounts, XMPP accounts, Windows Outlook accounts, and Mac
Address Book accounts.

A SIP account is used to make voice and video calls in Bria 5. Each user requires at
least one SIP account. The SIP account can also be used for presence and messaging if
your VoIP service provide supports SIP SIMPLE.

An XMPP account can be used for presence and messaging. An XMPP account is not
required.

On Windows, an Outlook account can be used to provide Bria 5 with access to the
contacts in your address book. A Windows Outlook account is not required.

On Mac, your Mac Address Book account is used to import your contacts into Bria 5. The
Mac Address Book account is automatically created in Bria 5.

Setting up a SIP account
You need the following information from your VoIP provider to set up your SIP account:

SIP account requirements
l User ID

l Domain

l Password

l Authorization name, if used by your service provider

l Voicemail number, if used by your service provider

You may also require your:

l Firewall traversal method

l Server address
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l Server user name

l Server password (optional)

l Port ranges (optional)

Note: See Transport settings (SIP) for more information.

Setting up your SIP account

You can set up your SIP account when you first launch Bria 5 or you can add a SIP
account on a subsequent start up.

To set up your SIP account on initial start up

1. Click Account Settings.

The SIP Account window opens.

2. In the Account tab, complete the following information:

l Account name: A name that helps you distinguish the SIP account

l User details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

3. If your VoIP service requires you to set up voicemail in Bria 5 complete the
following information in the Voicemail tab:

l Number to dial for checking voicemail: The number provided by your VoIP
service provider to access your voicemail
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l Number for sending calls to voicemail: The number provided by your VoIP
service provider to send calls to your voicemail

l Send calls to voicemail if unanswered for: Then number of seconds Bria 5
should wait before sending an unanswered call to voicemail

4. Complete the remaining tabs as specified by your VoIP service provider or to suit
your setup. Settings that you may need to change immediately are:

l The Proxy Address on the Account panel.

l The Firewall Traversal and Port Ranges on the Topology tab.

See Accounts or General panel (SIP) and Topology panel (SIP) for more
information on these settings.

5. Click OK.

The SIP account is created. Check Account Settings to make sure that the SIP account
is registered. If the account does not register successfully, review the information you
have added for the account or check with your system administrator or your VoIP service
provider to make sure you have all the correct information.

Your SIP account is ready for voice and video calls.

To set up a SIP account on a subsequent start up – Windows

1. On the Softphone menu, click Account Settings.

The Account Settings window opens.

2. Click Add and click SIP Account….
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The SIP Account window opens on the Account tab.

3. In the Account tab, complete the following information:

l Account name: A name that helps you distinguish the SIP account

l User details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

4. If your VoIP service requires you to set up voicemail in Bria 5 complete the
following information in the Voicemail tab:

l Number to dial for checking voicemail: The number provided by your VoIP
service provider to access your voicemail

l Number for sending calls to voicemail: The number provided by your VoIP
service provider to send calls to your voicemail

l Send calls to voicemail if unanswered for: Then number of seconds Bria 5
should wait before sending an unanswered call to voicemail

5. Complete the remaining tabs as specified by your service provider or to suit your
setup. Settings that you may need to change immediately are:

l The Domain Proxy area on the Account tab.

l The Topology tab if your computer is on a network and / or if you computer is
behind a firewall.

See Accounts or General panel (SIP) and Topology panel (SIP) for more
information on these settings.

6. Click OK.

The SIP account is created. Check Account Settings to make sure that the SIP account
is registered. If the account does not register successfully, review the information you
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have added for the account or check with your system administrator or your VoIP service
provider to make sure you have all the correct information.

Your SIP account is ready for voice and video calls.

To set up a SIP account on a subsequent start up– Mac

1. Click Preferences on the Bria 5 menu.

The Account Settings window opens.

2. Click on the Accounts tab.

3. Click Add and click SIP Account….

The SIP Account window opens on the Accounts tab.
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4. In the Account tab, complete the following information:

l Account name: A name that helps you distinguish the SIP account

l User details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

5. If your VoIP service requires you to set up voicemail in Bria 5 complete the
following information in the Voicemail tab:

l Number to dial for checking voicemail: The number provided by your VoIP
service provider to access your voicemail

l Number for sending calls to voicemail: The number provided by your VoIP
service provider to send calls to your voicemail

l Send calls to voicemail if unanswered for: Then number of seconds Bria 5
should wait before sending an unanswered call to voicemail

6. Complete the remaining tabs as specified by your service provider or to suit your
setup. Settings that you may need to change immediately are:

l The Domain Proxy area on the Account tab.

l The Topology tab if your computer is on a network and / or if you computer is
behind a firewall.

See Accounts or General panel (SIP) and Topology panel (SIP) for more
information on these settings.

7. Click OK.

The SIP account is created. Check Preferences – Accounts to make sure that the
SIP account is registered. If the account does not register successfully, review the
information you have added for the account or check with your system
administrator or your VoIP service provider to make sure you have all the correct
information.

Your SIP account is ready for voice and video calls.

Setting up multiple SIP accounts

You can set up Bria 5 so that you can make and receive calls from more than one SIP
account.
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To set up additional SIP accounts

1. Follow the steps in To set up your SIP account on a subsequent start up above to
add another SIP account.

2. Select your Preferred account for calls in Account Settings.

Bria 5 has multiple SIP accounts available for calls.

Choosing account for outgoing calls

Decide how you want Bria 5 to choose the account to use on outgoing calls. There are
two options:

l Dial plan decides: The dial plans must be designed so that they select the
appropriate account based on the number being dialed. You can still designate
one account as the preferred account. This account will be used if none of the dial
plan rules apply to the number being dialed.

l User selects: The user can select the account to use on an outgoing call. Your
administrator may need need to advise users on which account to use for which
type of call. For example, “Use Account 1 for internal calls”.
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If you are a system administrator and implementing Dial plan decides, modify the dial
plans as required. See Using a Dial Plan to Modify How Calls are Placed. Advise users
if they should use the account selection feature.

Setting up an XMPP account
You need the following information from your XMPP provider to set up your XMPP
account.

XMPP account requirements
l User ID

l Domain

l Password

You may also require your:

l Connect port

l Outbound proxy

Note: See XMPP account for more information.

Setting up your XMPP account

You can set up your XMPP account in Account Settings.

To set up an XMPP account

Windows

1. Click Softphone > Accounts Settings.

2. Click Add > XMPP Account….

3. Complete the following information:

l Account name: A name that helps you distinguish the XMPP account

l User Details: The login information provided by your VoIP service provider
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l Display name: The name you want to appear in caller ID

4. Complete the Advanced section as specified by your service provider or to suit
your setup.

See XMPP account for more information.

5. Click OK.

Your XMPP account is ready for presence and messaging.

Mac

1. Click Preferences on the Bria 5 menu. Click Accounts on the Preferences
window. The Account Settings panel opens.

2. Click + and click New XMPP Account.

3. Complete the following information:

l Account name: A name that helps you distinguish the XMPP account

l User Details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

4. Complete the Advanced section as specified by your service provider or to suit
your setup.

See XMPP account for more information.

5. Click OK.

Your XMPP account is ready for presence and messaging.

XMPP cross-domain

Bria 5 supports the XMPP cross-domain feature. With this feature, the user can send and
receive IMs and presence subscriptions for addresses that are foreign to any of the
XMPP accounts set up in Bria 5. For example, if the XMPP account is jabber.com, the
user can receive IMs from kperera11@acphone.com without having to set up
acphone.com as an XMPP account.
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Account selection

If two XMPP accounts are set up, traffic from a foreign domain will go through one of the
accounts. Usually, it will go through the first enabled account on the list. The foreign
domain address is linked to the XMPP account that the message went through. This
XMPP account must be enabled for to receive the subscription information from the
foreign domain address.

The server must allow passthrough of foreign addresses. Bria 5 allows the user to
attempt to subscribe to the foreign XMPP account but the subscription request may not
get sent.

Setting up Windows Outlook accounts
Your Windows Outlook account can be used to integrate your Outlook contacts in Bria 5.
This section describes how to integrate Outlook contacts so they remain in sync. You
need to map Outlook contact information to fields in Bria 5 in order to make calls and
send messages to Outlook contacts.

To add your Outlook account

1. On the Softphone menu, click Account Settings. The Account Settings window
opens.

2. Click Add and click Outlook Account. The Outlook Account window opens on the
Account tab.

3. Select the Outlook profile you want to use from Outlook profile if you have more
than one profile.

4. Select the Outlook contact field that you use for softphone addresses from Field to
use for Softphone address.

5. Select the Outlook contact field that you use for IM addresses from Field to use for
IM address.

6. Click OK.

Bria 5 creates the Outlook account.
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Setting up Mac Address Book accounts
Bria 5 automatically pulls the Mac Address Book account contacts into Bria 5’s contacts.
You can phone or IM them directly from Bria 5.

Bria 5 creates the Mac Address Book account is automatically. To use the Mac Address
Book account, make sure Enabled is selected in the Account Settings window.

Using you Mac Address Book for presence

If your Mac Address Book contains phone numbers that you know can be used to obtain
online activity information about the person through your SIP account, you can perform
this additional step.

To set up for presence

1. In the Mac Address book make sure that the contact type is Phone and the label is
softphone (in lower case).

2. Enable your Mac Address Book account in Bria 5 > Preferences > Account
Settings. Bria 5 pulls in the contact with the specified number already set up as a
softphone address.

3. Open the contact in Bria 5 and choose the specified phone number in the Primary
Presence field and click OK.

Bria 5 obtains the presence for this contact.

Using the Bria 5 interface
You can navigate in Bria 5 using the icons on the resource panel and the Bria 5 menu.

You can rearrange the order of the icons on the resource panel by dragging and
dropping them into your preferred order.

Windows

The Windows on-screen phone
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Compact view
To create the compact view, hide all the resources using the View menu.

Bria 5 menus
The Softphone, View, Contacts, and Help menus are available in the Bria 5 menu.

Softphone menu

l Account settings: Account settings apply to individual accounts. These settings
control how you interact with your VoIP service provider. See Configuring Bria 5 –
Accounts for more information.
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l Preferences: Preferences apply to all accounts. These settings control the way
you work with Bria 5. See Configuring Bria 5 – Preferences for more information.

l Sign out: Sign out logs you out of Bria 5 and Bria 5 displays the log in screen. This
menu item only shows when you select Softphone > Preferences – Application >
Enable Sign In.

l Exit: Use Exit to shut down Bria 5. You can also use CTRL+Q.

View menu

Use the View menu to change how Bria 5 looks. In the View menu, you can show or
hide which resources are on the resource panel, open the Messages windows, and view
your Video.

Contacts menu

Use the Contacts menu to add contacts and groups, and to change the way your
contacts are displayed in Contacts and Favorites.

Help menu

The Help menu provides support for Bria 5. Use the Help menu to access CounterPath
Technical Support, access the online user guide, troubleshoot problems, check for
updates, add features, and enter license key information.

Detaching tabs
The Contacts, Favorites, History, and the Directory panels can all be detached from the
on-screen phone into their own window. On the resource panel, click on the tab you
want to detach and then click Detach window. To return the window to the on-screen
phone, click Move back to main window.

CounterPath Corporation 25

Bria 5 User Guide Getting started

https://support.counterpath.com/
https://support.counterpath.com/
https://www.counterpath.com/resources/bria5-user-guide


Mac

The Mac on-screen phone

Compact view

To create the compact view, hide all resources on the View menu.
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Bria 5 menus

The Bria 5 menu

The Bria 5 menu allows you to set up your accounts and preferences, change the look of
the Bria 5 interface, work with contacts, and find support for Bria 5.

l Preferences: Preferences apply to all accounts. These settings control the way
you work with Bria 5.

l Accounts Settings: Account settings are found in the Preferences menu. Account
settings apply to individual accounts. These settings control how you interact with
your VoIP service provider.

l Quit: Use Quit to shut down Bria 5. You can also use COMMAND+Q.

View menu

Use the View menu to change how Bria 5 looks. In the View menu, you can show or
hide which resources are on the resource panel.

Windows menu

Use the Windows menu to Show Messages, Show Video, and Show Chat Rooms.

Contacts menu

Use the Contacts menu to add contacts and groups, and to change the way your
contacts are displayed in Contacts and Favorites.

Help menu

The Help menu provides support for Bria 5. Use the Help menu to access CounterPath
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Support Center, access the online user guide, troubleshoot problems, check for updates,
add features, and enter license key information.

Managing Bria 5 licenses as an end user
You need to manage Bria 5 licenses in the following situations:

l At initial setup if the license key is not provided via provisioning.

l When you purchase an add-in for Bria 5, the additional key must be entered in Bria
5. There are currently no add-ins for Bria 5.

l When you get a new computer, the current license keys must be transferred to the
new computer.

To enter license keys

1. Click Enter License Key on the Help menu. The License Key Management
window appears.

2. Do one of the following:
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l Type or paste your license key into Enter Your License Keys and click Add.
Repeat for each license.

l Click Import Keys, and choose the text file that contains the license keys.
The keys appear in the dialog.

3. Click Done.

The license key or keys display in the License Key Management window.

To transfer license keys to a new computer

1. On the current computer, start Bria 5 and click Enter License Key on the Help
menu. The License Key Management window appears.
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2. Click Export Keys.

3. Name the file, set the location to save the file, and click Save. Bria 5 creates a text
file with all the keys listed.

4. Transfer the text file to the new computer.

5. Log in to the CounterPath store. and go to Your Account > Single Group License
Manager or Your Account > Individual License Manager depending on the type of
license you are using. A list of your licenses appears.

6. Do one of the following:

Single Group License

l Click on the license key you want to move to the new computer. A list of
computers used with the license appears. Clear Enabled beside the old
computer.

Individual License

l Click on the license key you want to move to the new computer and clear
Enabled.

7. On the new computer, start Bria 5 and click Enter License Key on the Help menu.
The License Key Management window appears.

8. Click Import Keys, and choose the text file that contains the license keys. The keys
appear in the dialog.

9. Click Done.

The license keys are now in Bria 5 on your new computer.

CounterPath Corporation 30

Bria 5 User Guide Getting started

https://secure.counterpath.com/Store/CounterPath/Login.aspx?ReturnUrl=%2fStore%2fCounterPath%2fMembers%2fDefault.aspx


Note: Bria 5 licenses can bemoved when replacing a machine, they cannot be routinely moved
betweenmachines.

Configuring OS notifications
Bria 5 uses OS notifications. This section describes how to set these notifications.

When you have configured the OS notifications, make sure that the notifications are also
set up in Preferences: Alerts and sounds panel.

For information on the device that Bria 5 uses for ringing, incoming audio, and incoming
video, see Preferences: Devices panel.

To set up notifications on Windows 10

1. From the Start menu, select Settings > System > Notifications & actions.

2. Under Get notifications from these senders, click the entry for Bria 5.

3. Choose the notification style and preferences.

To set up notifications on a Mac

You can choose banner or alert style notifications. Banner style notifications appear
briefly in the top corner of the screen. Alert styles notifications appear and remain on the
screen until you take action on them.

1. Click the Apple icon on the Bria 5 menu and click System Preferences >
Notifications.

2. Click Bria 5.

3. Choose the banner or alert notification style for incoming alerts.

You will receive either a banner or alert notification when you have an incoming call or
instant message on Bria 5.
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Checking for Bria 5 software updates
If you are in an enterprise, your system administrator should tell you about the policy for
checking for and installing updates.

Click Check for Updates on the Help menu to see if there is an update available. The
Auto Update (Windows) or the Auto Upgrade (Mac) window opens.

If a new version of the software is available, you can download it from this window. If no
newer version is available, this window informs you that your version is up to date.
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Calls

You can use Bria 5 to place and receive audio and video calls, as well as host
conference calls. You can forward, transfer, and record calls.

A user must have at least one SIP account registered in order to place and receive calls.

In addition to a SIP account, a speaker and a microphone are necessary for audio calls.
For video calls, you also require a video camera to allow the remote parties to see your
image. Bria 5 works with most USB video cameras.

You can test your devices in Softphone > Preferences > Devices (Windows) or Bria 5 >
Preferences > Devices (Mac).

Placing an audio or video call
Place audio and video calls in Bria 5 from the dialer, Contacts, Favorites, Directory (if
available), History, or Messages.

Bria 5 has default actions for the call button and for double-clicking a contact. Set the
default actions in the Preferences > Application: Default Actions .

Using the dialer
Enter a name or phone number in Bria 5's dialer to make a voice or video call from any
tab on the resource panel.

To place a call using the dialer using auto-complete

1. Type the name, phone number, jid, or email of the person you want to call in the
Enter name or number field. As you type, Bria 5 may display suggestions for
completing the entry.
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2. Press ENTER after typing the full name, phone number, jid, or email or use the up
and down arrow keys on your keyboard to move through the list of suggestions and
press ENTER or TAB to dial.

Bria 5 makes the call.

To place a call using the dialer using Make a call or Make a video call

1. Click Make a call or Make a video call after typing the full name, phone
number, jid, or email.

2. Do one of the following:

Bria 5 makes the call.

To place a call using the dialer using the More menu

1. Select Audio Call or Video Call from the More call options menu after typing the
full name, phone number, jid, or email.

Bria 5 makes the call.
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Using redial
Redial a number by clicking Make a call or Make a video call or by using the List of
recent calls.

To redial using Make a call or Make a video call

1. Tap Make a call or Make a video call beside Enter name or number.

The last number dialed appears.

2. Tap Make a call or Make a video call a second time.

Bria 5 makes the call.

To redial using the More menu

1. Tap Make a call or Make a video call beside Enter name or number.

The last number dialed appears.

2. Select Audio Call or Video Call from the More call options menu.
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Bria 5 makes the call.

To redial using the List of recent calls

Bria 5 places an audio call when you use the drop-down list even if the call was a video
call.

1. Tap the List of recent calls drop-down arrow in the Enter name or number field. A
list of recent calls appears.

2. Click the number or person you want to call.

Bria 5 places the audio call.

Using Contacts, Favorites, or Directory
Make calls on Bria 5 using the click-to-call button, single-click, double-click, or the
shortcut menu in Contacts, Favorites, or Directory (if available).

To place a call using the click-to-call button

1. Type a name in Search Contacts, Search Favorites, or Search Directory or scroll
through Contacts, Favorites, or Directory and find the contact your want to call.
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You can also use phone number, jid, or email.

2. Hover on the contact you want to call to reveal the click-to-call button and click
Call this contact.

Bria 5 makes the call.

To place a call using the Contact Info flyout

1. Type a name in Search Contacts, Search Favorites, or Search Directory or scroll
through Contacts, Favorites, or Directory and find the contact your want to call.
You can also use phone number, jid, or email.

2. Click on the contact or number you want to call. A Contact Info flyout with the
persons information opens.

3. Click the number you want to call in the Contact Info flyout.

Bria 5 makes the call.

To place a call using the shortcut menu

1. Type a name in Search Contacts, Search Favorites, or Search Directory or scroll
through Contacts, Favorites, or Directory and find the contact you want to call.

2. Right-click (Windows) or CTRL+click (Mac) on the contact you want to call and
click Call or Video Call.
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3. If the contact has more than one number, click the number you want to call.

Bria 5 makes the call.

To place a call using double-click

Double-click only works if the default action is set to Call or Make a video call. The
action for double-click is set in Preferences > Application: Default Actions.

1. Type a name, phone number, jid, or email in Search Contacts, Search Favorites,
or Search Directory or scroll through Contacts, Favorites, or Directory to find a
contact.

2. Double-click the contact or number that you want to call.

Bria 5 makes the call.

Using History
Make calls on Bria 5 from History using Make a call, using the shortcut menu, or using
the Contact Info flyout.

Making a call from the Contact Info flyout only works if the person is one of your
Contacts. You may want to use the Contact Info flyout when the person you want to call
is in History but you want to reach them at a different number than the one in History.

To place a call using Make a call

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Click on the group to expand it.
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3. Click Make a call.

Bria 5 makes the call.

To place a call using the shortcut menu

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Right-click (Windows) or CTRL+click (Mac) on the History group and click Call or
Video Call.

Bria 5 makes the call.

To place a call using the Contact Info flyout

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Click Contact Info.
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3. Click the number on the Contact Info flyout that you want to call.

Bria 5 makes the call.

Using Messages
From the Messages windows, call the message sender or call a number in a message.

To place a call using Make a call and Make a video call

1. Bring an IM into focus from the person you want to call by clicking on the message
or entering the person’s name in the Search Messages field and clicking on the
message.

2. Click Make a call or Make a video call in the IM header.
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Bria 5 makes the call to the default number for the contact.

To place a call using the More menu

1. Bring the IM into focus by clicking on the IM or entering the person’s name in the
Search Messages field and clicking on the message.

2. Click More options for this contact (Windows) or More options for this
conversation (Mac) in the IM header. If the person has more than one phone
number, choose the phone number you want to call.

Bria 5 makes the call.

To place a call using the shortcut menu (Windows only)

1. Right-click on an IM and select Call or Video call. If the person has more than one
phone number, choose the phone number you want to call.
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Bria 5 makes the call.

To place a call to a number sent in an message

1. Click on the number you received in an IM.

Bria 5 makes the call.

From Microsoft Outlook
If you are using Outlook integration with Bria 5, you can place calls directly from Outlook.

You can place an audio or video call from the mini-contact card to an Outlook contact
that you have a phone number or softphone number for.

To place a call

1. Hover over a person’s name anywhere in Outlook. The mini-contact card appears.

2. Click on Call or Start video call.

CounterPath Corporation 42

Bria 5 User Guide Calls



Bria 5 places the call or video call and opens the call panel. If you clicked Start video
call, Bria 5 opens the Video window if the remote party answers the call with video.

If a contact has more than one number, you can choose the number you want to call.

To place a call to a contact with multiple numbers

l Click the drop-down arrow beside Call or Start video call and select the
number that you want to call.

Bria 5 places the call or video call and opens the call panel. If you clicked Start video
call, Bria 5 opens the Video window if the remote party answers the call with video.

Selecting the account to use
The account selection options appear only if you have two or more SIP accounts
enabled and set up for phone calls. To enable phone calls on a SIP account, go to
Softphone > Account Settings (Windows) or Preferences > Account Settings (Mac).
Select the SIP account. On the Account (Windows) or General (Mac) tab, make sure
Call is selected in Allow this account for.

The default Outgoing Account is Auto Select. Bria 5 selects the account based on your
dial plan rules. If there are no dial plan rules, Bria 5 will use the account set as preferred
in Softphone > Account Settings (Windows) or Preferences > Account Settings
(Mac).

To set your Preferred account for calls

1. Click Softphone > Account Settings (Windows) or Preferences > Account
Settings (Mac). The Account Settings window opens.

2. Select the account you want prefer to use from the Preferred account for calls
menu.
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Bria 5 uses this account for outgoing calls if you do not have any dial plan rules or have
not explicitly chosen a different account.

You can also explicitly specify which account you want to use for an outgoing call.

To select the account for an outgoing call

1. Click Outgoing Account.

2. Choose the account you want to use from the menu.

3. Place your outgoing call.

Bria uses the account you select for the outgoing call.

Note: Your system administrator may have set up a dial plan to select the correct dial out
account. Contact your system administrator for details.

Changing letters to numbers
Some phone numbers are given with words to help you remember them — “1-800-
numbers”. Rather than convert the letters to numbers — n=6, u=8, m=6, … to get 1-800-686-
2377 — you can type letters into Enter name or number and Bria 5 will convert the letters
to numbers when placing the call.

Turn Letters to Numbers is automatically turned off when you shut down or log off.

To change letters to numbers

1. Click More call options.
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2. Select Turn Letters to Numbers.

Letters To Numbers is enabled  is displayed beside More call options and a
check mark appears beside Turn Letters to Numbers on the More call options
menu.

3. Type the phone number using numbers and letters.

4. Click Make a call or Make a video call.

The call panel opens and the call is placed. The call panel shows the phone number all
in numbers.

Hiding your identity
You can hide your identity on a call so that the remote party will not see your name or
number on their phone. Anonymous calling is automatically turned off when you shut
down or log off.
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To hide your number

1. Click More call options.

2. Select Hide my Number.

Anonymous Calling is enabled is displayed beside More call options and a
check mark appears beside Hide my Number on the More call options drop-
down menu. Your ID will be hidden for all outgoing calls until you turn off
anonymous calling.

Changing video options
Video can be added or removed from an established call. If the remote party starts
sending video, your video window opens automatically and their video plays. Your video
is only sent to the remote party if you add it to the call.

To add video to an audio call
1. Click Start Video at the bottom of the call panel.
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Bria 5 sends your video to the remote party. The remote party may or may not send their
video to you.

To stop and resume video
1. Click the Pause sending video icon at the bottom of the call panel or the video

window to pause or end your video. You can also close the video windows to stop
sending video. Closing the video window does not end the call.

2. Click Start Video at the bottom of the call panel or on the video window toolbar
or the open the video window to resume sending your video.

Bria 5 starts or stops sending your video.

To show and hide the video preview
Bria 5 can show you a preview of the video you are sending.

1. Click on the video window if it is not in focus and hover over the video window.

2. Click the Toggle local video view icon.
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Bria 5 toggles the local video view on and off.

To expand and exit full screen video
1. Click on the video window if it is not in focus and hover over the video window.

2. To view in full screen click the
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Full screen or press F11 (Windows only).

3. To close full screen view click Exit full screen or press ESC (Mac only).

The video window screen changes size.

To change video settings
1. Click the Camera settings icon at the bottom of the video window.

2. Use the drop down menus to change your video device or change your video
resolution.

Bria 5 changes the video settings.

Placing simultaneous calls
You can make up to five concurrent calls on Bria 5.

To place a second call

To place a second call, use any of the methods for placing an audio or video call when
you have a call established. Bria 5 automatically puts the first call on hold and dials the
second call.
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Bria 5 displays a call panel for each call.

To swap between calls

1. Click Take this call off hold on the call you want to switch to.

Bria 5 puts the active call on hold and switches to the other call.

Dealing with an auto attendant (Pause dialing)
You can use DTMF or pause dialing for auto attendant when you dial call or during a
call.

Using DTMF when you dial a call
If you know that your call will be answered by an auto attendant and you know what
menu items you will choose, you can include those menu items (DTMF) in the phone
number when you dial it.

Use the DTMF dialing rules to append the number you dial.

CounterPath Corporation 50

Bria 5 User Guide Calls



DTMF dialing rules

l Include at least one capital P before the first DTMF number. Each P causes Bria 5
to pause for one second before sending the next character.

l You can include other P’s.

l At the end of the input, include a ; (semi-colon).

Note: Make sure to enter a ; (semi-colon) when you are done entering pauses and DTMF
numbers or Bria 5 will not be able to complete the call.

Examples

Example 1

To dial a number, add a 3-second delay and then press 44, enter this in
the call entry field:

6045551212PPP44;

Example 2

To dial a number, add a 6-second delay, then press 1 then 3 then 2,
each with a two second delay:

6045551212PPPPPP1PP3PP2;

A capital X or a , (comma) can be used instead of P; the following will
work in the same way as the first example above.

6045551212XXX44;

Tip: You can save a number in this format in your contacts.
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Using DTMF during a call
Once you have dialed a call, you may need to use DTMF to enter an extension number,
follow voice prompts, or enter a conference code.

To use DTMF during a call

1. Click Show/Hide DTMF.

The DTMF field opens.

2. Type the required DTMF numbers.

3. Click Show/Hide DTMF to close the DTMF field.

Bria 5 plays the DTMF tones.
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Handling an incoming call
Bria 5 must be running to answer incoming calls. It can be running in the system tray. If
Bria 5 is not running, incoming calls may be directed to voice mail if you have this
service. Check with your VoIP service provider or your system administrator.

When Bria 5 is in the foreground, the call appears in the call panel in the Bria 5 interface.
When Bria 5 is in the either the foreground or the background, you may also receive a
notification for the incoming call depending on your settings. To receive notifications on
a Mac, also set the system preferences.

Answering on the call panel
You can answer a call on the call panel or using the notification.

To answer a call on the call panel

1. Click an action button.

One of the following results occurs depending on the action button you choose:

Icon and Meaning - Windows

Answer incoming call: The incoming audio call is answered with audio. If you were
on another call, Bria 5 places the first call on hold.
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Answer incoming call with audio only: The incoming video call is answered with
audio only. If you were on another call, Bria 5 places the first call on hold.

Answer incoming call and start sending my video: The incoming video call is
answered with video. If you were on another call, Bria 5 places the first call on hold.

Forward this call to another person without answering: The incoming call is
forwarded without answering it first. A call entry field appears. Enter the name or number
you want to forward the call to and click Forward.

Refuse incoming call: The call is declined and the remote party gets a busy signal or
the call is forwarded to voice mail if you have this service.

Icon and Meaning - Mac

Answer call: The incoming audio call is answered with audio. If you were on another
call, Bria 5 places the first call on hold.

Answer with audio only: The incoming video call is answered with audio only. If you
were on another call, Bria 5 places the first call on hold.

Answer with video: The incoming video call is answered with video. If you were on
another call, Bria 5 places the first call on hold.

Forward call: The incoming call is forwarded without answering it first. A call entry
field appears. Enter the name or number you want to forward the call to and click
Forward Call.

Reject call: The call is declined and the remote party gets a busy signal or the call is
forwarded to voice mail if you have this service.

Answering notifications
In Windows, you will receive Windows 10 interactive toast notifications or Windows 7
style notifications. In Mac, you will receive banner style notifications or alert style
notifications.

To use Windows interactive toast notifications, you have to enable Use Windows
notifications in Softphone > Preferences > Alerts & Sounds.
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To answer Windows 10 interactive toast notifications

1. Click Answer, Decline, or Decline with message in the interactive toast
notification. When you click Decline with message, the message you enter is sent
to the caller as an IM.

To answer Windows 7 style notifications

You can answer a call with the notification by clicking Answer incoming call, Answer
incoming call and start sending my video, or Refuse incoming call.

To answer Mac notifications

Banner style notifications appear briefly in the top corner of the screen. They will
disappear on their own. To answer a call, click on the notification. This brings Bria 5 into
the foreground and you can answer the call using the call panel.

Alert styles notifications appear and remain on the screen until you take action on them.
You can click Answer or Decline on the alert. You can click anywhere else on the
notification to bring Bria 5 into the foreground and answer the call using the call panel.
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The notifications do not indicate whether the incoming call is an audio call or a video
call. If the incoming call is a video call, Bria 5 will answer with video. If you do not want
video, you can stop sending video once the call is established.

Enabling auto answer
You can turn on Auto Answer so the call is automatically answered by Bria 5 after a
specified period of time with no user intervention. Auto Answer is initially configured to
answer calls after 3 seconds. Go to Preferences > Calls to change the configuration.

You can enable this feature during a call and it takes effect right away. When the call is
established, Bria 5 sends your audio only.

To enable Auto Answer

1. Click More call options.

2. Select Auto Answer.

Auto Answer is enabled is displayed beside More call options and a check mark
appears beside the Auto Answer on the More call options drop-down menu. Any
new incoming call are automatically answered.
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Disabling call waiting
You can turn on Disable Call Waiting so active calls are not interrupted by incoming
calls. You can enable this feature during a call and it will take effect right away. The calls
will appear as Missed Calls in the List of recent calls (Windows) or History (Mac). Any
new incoming calls ring busy (to the caller) or go straight to voice mail if you have this
service.

To disable call waiting

1. Click More call options.

2. Select Disable call waiting.

Call Waiting is disabled is displayed beside More call options and a check mark
appears beside the Disable call waiting on the More call options drop-down menu.

Transferring a call
There are two types of call transfers. A unattended or blind transfer occurs when you
transfer a call without talking to the target – the person you are sending the call to. An
attended transfer occurs when you talk to the target before transferring the call.

The Bria 5 transfer button can be set with Transfer Now or to Call First as the default.
You can set the default in the Preferences: Application panel
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Unattended transfer
In an unattended or blind transfer, you transfer the call to the target without talking to the
target first.

To transfer a call

1. Click Transfer this call (Windows) or Transfer (Mac) at the bottom of the call
panel. Bria 5 puts the call on hold.

2. Type the name or number of the target, use the redial drop-down list, or drag the
target’s contact into the Enter name or number field.

3. Click Transfer Now if it is your default or click the drop-down arrow beside Call
First and click Transfer Now.

Bria 5 attempts to transfer the call to the target. The call may end immediately or may
show Transfer: Calling. If you see Transfer: Calling, do not hang up. If the target does
not answer, the call will return to you.
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Attended transfer
Transfer the call to the target after speaking to the target.

To transfer a call

1. Click Transfer this call (Windows) or Transfer (Mac) at the bottom of the call
panel. The call is put on hold.

2. Type the name or number of the target, use the redial drop-down menu, or drag the
target’s contact into the Enter name or number field.

3. Click Call First if it is your default or click the drop-down arrow beside Transfer
Now and click Call First.

Bria 5 phones the target. When the target answers, Transfer Now is enabled

4. Speak to the target. If the target wants to take the call, click Transfer Now
(Windows) or Transfer now (Mac). If the target does not want to take the call,
click the X at the bottom of the call panel.
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Bria 5 transfers the call to the target if the target accepts the call.

Forwarding a call
You can forward an incoming call instead of answering it. Calls show up as missed calls
in History.

To forward a call

1. Click Forward call on the call panel.

2. Type the name or number of the target, use the redial drop-down list, or drag the
target’s contact into the Enter name or number field.

Bria 5 forwards your call.

Encrypting a call
The outgoing call may be encrypted depending on your security settings.

l If an encrypted call is established, the security lock appears on the call panel.

l If an unencrypted call is established, no encryption icon appears.
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Note: If a call cannot be established using the specified security, the call will fail.

Recording a call
You can record the audio portion of a one-to-one call or a conference call.

Files created when recording
Recording are saved as .wav files on your computer. The location to save recordings
can by set by your system administrator or in the Preferences > Files and web tabs
panel. (Mac). If you do not see Preferences > Files and web tabs, talk to your system
administrator.

Files created for conference calls

Multiple files may be created depending on how and when you start recording. If you
start recording from the beginning of a conference call and continue recording until the
call ends, one file is created.

If you separate a participant from the conference call and have a one-to-one call, the
recording continues until the end of the one-to-one call. Two files are created: one for the
conference call and the other for the one-to-one call.

Files created when forming conference calls from one-to-one calls

If you are recording one-to-one calls and you merge them to form a conference call, all
the individual recordings stop and a new recording is created for the conference call.

If you are recording one-to-one calls and you add them to an existing conference call, all
the individual recordings stop. If the conference call was being recording before the
merge, the recording of the conference call continues.

Creating a call recording
You can record the audio portion of a call in progress.
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To start a call recording

1. Click More options for handling this call (Windows) or More options (Mac).

2. Click Start Call Recording.

Bria 5 starts recording the call. The call panel shows a call recording indicator.

Stopping recording a call
You can stop recording a call using the More menu or using the recording icon.

To stop recoding a call using the More menu

1. Click More options for handling this call (Windows) or More options (Mac).

CounterPath Corporation 62

Bria 5 User Guide Calls



2. Click Stop Call Recording to end the call recording.

Bria 5 stops recording the call.

Using the Stop Call Recording

1. Click the Stop Call Recording.

Bria 5 stops recording the call.

The first time you record a call, a Save Call Recording dialog appears. The dialog
displays the Recording name and the Saved in location. You can select Don’t show this
dialog again if you do not want to see the dialog after every recorded call. Click Open
Folder to open the folder where the file is saved.
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Playing back a call recording
You can play a call recording back directly from Bria 5 using History or you can use a file
explorer and your default app to play the recording.

To play back a recording using History

1. Go to the History tab on the resource panel.

2. Optional: Click on the filter and select Recordings.

3. Click on the History group that contains the recording. The History group expands.

4. Click on the call entry that contains the recording. The call entry expands.

5. Click Play Recording.

Bria 5 plays the recording in your default audio player.

To play back a recording using file explorer

1. Locate the .wav file from the location it was saved in.
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2. Double-click on the file. The file opens in your default audio player.

3. Use the controls in the audio player to play back the recording.

The recording is played in the default audio player.

Ending a call
To end a one-to-one or conference call, click End call on the bottom of the call panel.
The call panel closes after a few seconds.

To end a video call, click End call on the bottom of the call panel or click End call
in the video window tool bar.

In Windows, you can end a call by right-clicking the Bria 5 icon in the taskbar and
clicking End Call.

In Mac, you can end a call by using CONTROL + click on the Bria 5 icon in the dock and
click End Call.
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Conference calls

Use Bria 5 for six-party audio conferencing and six-party video conferencing (you and
five other participants) where you are the host.

With Bria 5, you can create a conference call, add participants to an existing conference
call, remove a participant from a conference call, send instant messages to conference
participants, and place the conference call on hold.

Creating a conference call
You can create a conference call or you can add participants to an existing call. Once a
conference call is created, you can add additional participants.

Creating a conference call
Create a conference call without an established call.

To create a conference call using the dialer

1. Type a number in Enter name or number.

2. Click More call options beside Make a call or Make a video call and select
Start Conference Call.
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Bria 5 connects the first participant.

3. Type a name or a number, use the redial drop-down, or drag a contact into the
Enter name or number field and click Add.

Bria 5 starts a three-party conference call.

4. To add more participants, click More options for handling this call (Windows) or
More options (Mac) and click Invite to Conference Call.

5. Enter a name or a number, use the redial drop-down list, or drag a contact into
Enter name or number at the bottom of the call panel and click Add.
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Bria 5 adds the new participant.

6. Repeat steps 4 and 5 until you have added all the participants to the conference
call.

Bria 5 creates a conference call.

Adding participants to an established call
You can add participants to a one-on-one call or to an existing conference call.

Adding participants to an active call

You can use the More options for handling this call (Windows) or More options
(Mac) from an existing one-on-one call or from an existing conference call.

Using the More menu

1. Click More options for handling this call (Windows) or More options (Mac)
and click Invite to Conference Call from an established call.
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2. Type a name or a number, use the redial drop-down, or drag a contact into Enter
name or number and click Add. Bria 5 adds the new participant.

3. Repeat steps 1 through 3 until you have added all the participants to the
conference call.

Bria 5 creates a conference call.

Merging existing calls

You can create a conference call by merging two or more existing calls.

To add participants by merging calls

1. Establish the calls you want to merge.

2. On the active call, click More options for handling this call (Windows) or
More options (Mac) and click Merge Calls.
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Bria 5 creates a conference call.

Using the shortcut menu in Contacts or Favorites

You can add participants to an established one-on-one call or to an established
conference call using the shortcut menu in Contacts or Favorites.

To add participant using the shortcut menu

1. During an established call, go to the Contacts or Favorites panel.

2. Right-click (Windows) or CTRL+click (Mac) on a Contact or Favorite and click Add
to Call.
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Bria 5 creates a conference call.

Using the shortcut menu in History

You can add participants to an established one-on-one call or to an established
conference call using the shortcut menu in History.

To add participants by using the shortcut menu

1. During an established call, go to the History panel.

2. Right-click (Windows) or CTRL+click (Mac) on a History entry – expanded or
collapsed - and click Add to Call.
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Bria 5 creates the conference call.

External conference call
To join a conference call external to Bria 5, you may need to enter DTMF digits.

To use DTMF during a call

1. Click Show/Hide DTMF.

The DTMF field opens.
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2. Type the required DTMF numbers.

3. Click Show/Hide DTMF to close the DTMF field.

Bria 5 plays the DTMF tones.

Video conference calls
To use video conferencing, a video camera is necessary to allow the remote parties to
see your image. Bria 5 works with most USB video cameras. Video is sent to all
participants in a conference call.

Including video in a conference call
When you start a conference call from established calls, video is automatically included
if at least one of the established call includes video.

When you create a new conference call, video is not included.

CounterPath Corporation 73

Bria 5 User Guide Conference calls



To add video to a conference call

1. Click Start Video.

Video is sent to all conference participants. Participants can choose whether to share
their own video.

How video is shared
The conference host, the person who started the conference call, serves as the host for
the video feed. The video that the host sees is automatically sent to all participants.

If the conference host pauses or stops the video, the other participants no longer receive
video.

One person does not have video
Participants that have video see Video beside their name. If there are any participants
that do not have video, the host must stop and start the video.

Sending an instant message to a conference
participant
Send individual instant message (IM) to a conference participant.
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To send a participant an instant message (IM)
during the conference call
1. On an established conference call, click Send Instant Message beside the

name of the participant.

The Messages window opens.

2. Type the message in the Compose Message field.

3. Click Send Message or press ENTER.

Bria 5 sends the IM.

Putting a conference on hold
With Bria 5, you can put a conference call on hold.

To put a conference call on hold

1. Click Put conference call on hold at the bottom of the conference call panel.
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Bria 5 places the conference call on hold.

To resume a conference call

1. Click Take all participants off hold at the bottom of the conference call panel.

Bria 5 takes the conference call off of hold.

Speaking to a participant separately
During a conference call, you can speak to one of the conference participants separately
while maintaining the conference call.

To speak to one participant in a conference call

1. Click Separate Calls beside the participant you want to speak to.
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The conference is split into two calls. When you are finished speaking to the separate
participant, you can merge the two calls back into the conference call or end the one-on-
one call and return to the other conference call.

Removing a participant or ending a
conference call
You can remove a participant from the conference call and continue with call or you can
end the conference call.

To remove a participant

1. Tap End call beside the participant you want to remove.

Bria 5 ends the call with the participant. The call continues with the remaining
participants.
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To end a conference all

1. Click End call from the conference call panel.

Bria 5 ends the conference.
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Accessing voice mail

If your service includes voice mail and you have set up voice mail options, you can use
Bria 5 to access your VoIP service provider's voice mail services.

When you have a new message, an icon showing the number of messages shows on
Voice messages (Windows) or Voice Mail (Mac) .

To listen to your messages

1. Click Voice messages (Windows) or Voice Mail (Mac).

Bria 5 plays your messages.

Multiple SIP accounts
If you have multiple SIP accounts registered, clicking the Voice messages (Windows)
or Voice Mail (Mac) button reveals the number of messages for each SIP account.
Click the account that you want to hear the messages from.
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Messaging

There are two types of messages in Bria 5 - instant messages (IMs) and chat rooms. IMs
are messages that you send to an individual contact. Chat rooms have multiple
members and allow you to send messages to all the members of the room. IM's are
found in the People section of the Messages window. Chat rooms are found in the
Room section.

You can send IM's to any contact who has a softphone (if your SIP provider supports SIP
SIMPLE) or an XMPP address. To use chat rooms, you must have an XMPP account
registered and enabled.

You can use emoticons and formatting in your IM's and chat rooms. Use CTRL+B for
bold, CTRL+I for Italic, and CTRL+U for underline on Windows. Use COMMAND+B for
bold, COMMAND+I for Italic, and COMMAND+U for underline for Mac.

By default, SHIFT+ENTER (for Windows) or CONTROL + ENTER (for Mac) inserts a new
line in a message and ENTER sends the message. You can modify this behavior in
Preferences > Application panel: Messages & Presence.
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Opening the Messages window
There are several ways that you can open the Messages window.

Windows

l Click Show the messages window.

l Keyboard shortcut: CTRL+SHIFT+M

l Select View > Messages

l Click on an IM notification

Mac

l Click
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Show the messages window.

l Select Window > Show Messages

l Click on an IM notification

Instant messages
You can send instant messages (IMs) to a contact who has a softphone address (if your
provider supports SIP SIMPLE) or an XMPP address. You can delete the entire IM
session.

To send messages to more than one person, see Chat rooms.

Sending and receiving instant messages

Sending an instant message

Instant messages (IMs) can be sent from the Messages window, the Contacts panel, the
Favorites panel, or from an active call.
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Set the action for clicking ENTER while typing a message in Preferences > Application
panel: Messages & Presence.

Sending an IM from the Messages window

From the Messages window, you can start a new IM, send another message on an
existing conversation, or send an IM to a member of a chat room.

To start a new IM

1. Click New Conversation in the People section of the Messages window.

2. Type a name into Add recipients. As you type, Bria 5 may display suggestions for
completing the entry. Click on the person or press ENTER to select the recipient.

3. Type your message in Compose Message.

4. Click Send Message.

Bria 5 sends the IM.
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Add to an existing IM conversation

1. Click on an existing conversation in the People section of the Messages window.

2. Type your message in Compose Message.

3. Click Send Message .

Bria 5 sends the IM.

To send an IM from a chat room

1. Tap on the chat room in the Rooms section of the Messages window.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

3. Double click on their avatar.

If you already have an existing IM, Bria 5 opens it. If you do not have an existing IM, Bria
5 starts a new one.
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Note: If you do not have an XMPP account or your XMPP account is not registered, you do not
seeRooms and People. Click New Conversation instead of New Conversation.

Sending an IM from the Contacts or the Favorites panel

From the Contacts or Favorites panel, you can start a new IM using the shortcut menu or
using click-to-message.

To send an IM using the shortcut menu

1. On the Contacts or Favorites panel, right-click (Windows) or CONTROL+Click
(Mac) on a contact or a favorite and select Send Instant Message from the shortcut
menu. If there is more than one IM address, select the one you want to use.

2. Type your message in Compose Message.

3. Click Send Message.

Bria 5 sends the IM.

To send an IM using click-to-message

1. On the Contacts or Favorites panel, hover on the contact you want to message to
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reveal the click-to-message button. Click Instant message this person.

2. Type your message in Compose Message.

3. Click Send Message .

Bria 5 sends the IM.

Sending an IM from an active call

From an active call, you can send a message using More options for handling this
call (Windows) or More options (Mac).

To send an IM from an active call

1. During an active call, click More options for handling this call (Windows) or
More options (Mac) in the call panel and click Send Instant Message.

2. Type your message in Compose Message.

3. Click Send Message .

Bria 5 sends the IM.

CounterPath Corporation 86

Bria 5 User Guide Messaging



Tip: If Preferences > Application panel: Messages & Presence > In messaging, pressing
Enter will: is set to Send the message, you can use ENTER instead of clicking Send
Message.

Receiving an instant message

When you receive an IM, the Messages window opens or a notification appears. To
control the type of notification, go to Preferences >Alerts & Sounds (Windows) or
Preferences > Alerts (Mac) .

Windows 10 interactive toast notification

You can type your response directly into a Windows 10 interactive toast notification or
you can click on the notification to open it in the Messages window.

Windows 7 and Mac notifications

You click on the Windows 7 or a Mac IM notification to open it in the Messages window.

Deleting instant messages
You can delete an IM conversation from Bria 5. Before you delete a conversation, you
may want to export it.

To delete a conversation using Delete Conversation

1. Click Delete Conversation beside the session.
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A Delete Conversation dialog opens.

2. Click Yes (Windows) or OK (Mac).

Bria 5 deletes the session.

To delete a conversation using the More menu

1. Click on the session, click More options for this contact (Windows) or More
options for this conversation (Mac) and click Delete Conversation.

A Delete Conversation dialog opens.

2. Click Yes (Windows) or OK (Mac).

Bria 5 deletes the session.
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To delete a conversation using the shortcut menu

1. Right-click on the session and click Delete Conversation.

A Delete Conversation dialog opens.

2. Click Yes (Windows) or OK (Mac).

Bria 5 deletes the session.

Tip: If you selectDon’t show this warning again before clicking Yes on theDelete
Conversation dialog, you will not receive a warning before deleting sessions in the future.

Chat rooms
Chat rooms are used when sending messages to multiple recipients. Chat rooms can be
private or public. Private rooms can only be joined by invitation. Public rooms can be
joined by anyone in your XMPP group. Chat rooms are only supported with a single
XMPP account.

You can:
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l Create chat room.

l Join a chat room.

l Set up the type of notifications you want to receive for each chat room.

l Use mentions to get the attention of a specific chat room member.

l You can delete or leave a chat room.

Chat room server requirements
The following requirements must be met to use chat rooms:

l Your XMPP server must support:

l Multi-User Chat as defined in XEP-0045.

l Bookmarks as defined in XEP-0048.

l Private XML Storage as defined in XEP-0049.

l Entity Time as defined in XEP-0202

l Delayed Delivery as defined in XEP-0203

l All the clients must be running version 5.5.0 or higher on Windows and Mac.

l All the users must connect to the same XMPP server; in other words, their XMPP
accounts must have the same domain.

l Your XMPP account must be registered and enabled.

If your XMPP server does not support XEP-0045, you will not see Rooms in Messaging.

If your XMPP server does not support XEP-0048, XEP-0049, XEP-0202, and XEP-0203,
chat rooms may not work as designed. Users may see errors in the Rooms list, the time
stamps on messages may be incorrect, and some messages may not be sent to all
users.

If some clients are running versions earlier than 5.5.0 on Windows and Mac, the room
members list may not accurately show who is in the chat rooms and messages may not
be sent to all room members.

Chat room properties
Each chat room has a set of properties. Some are required and some are optional.
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Required chat room properties

Room name: Each room must have a unique room name. Up to 40 characters long.

Room Type: A room can be private or public. Private rooms are unlisted and can be
joined by invitation only. Public rooms are displayed in the list of chat rooms that you can
join.

Room owner: The name of the person that created the room.

Optional chat room properties

Members: The people you are inviting to the room or the people already in the room.

Description: Up to 140 characters long that can be edited by the room owner.

Topic: A brief description of what is currently being discussed in the group that can be
edited by anyone. Up to 140 characters long.

Creating a chat room
All Bria 5 users can create new private or public chat rooms. Public chat rooms can be
joined by anyone. Private chat rooms can only be joined by an invitation from the Room
Owner.

Chat rooms are assigned an avatar using the initials from Room Name. As you type in
Room Name, the color of the avatar changes as you type. The resulting color is
assigned to the chat room. Room Name can be up to 40 characters long and must be
unique. Room Name is case sensitive.

Description is an optional field. Description can be up to 140 characters long.

Creating a private chat room

You can create a private chat room from the Messages window, Contacts or Favorites.
When you create a private chat room, you invite people to join the room. Once the chat
room is created, you cannot remove a person from the room.
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To create a private chat room in Rooms

1. Click Join / Create a room and click Create a room on the Rooms section of the
Messages window.

2. Select Private for the Room Type.

3. Type in a Room Name.

4. Start typing the name of a contact you want to add to the room. As you type a
name, Bria 5 shows a list of suggestions. Select the person you want to invite from
the list.

If you want to remove someone from Members before you create the room, click
Remove.

5. Repeat the previous step until all the members you want to add are shown in
Members.

6. If desired, enter a brief Description of the room. This field is optional.

7. Click Create.
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Bria 5 creates the chat room and adds it to the Rooms section of the Messages window.
The Members you invited are automatically added to the room. The lock on the avatar
for the room indicates this is a private chat room.

To create a private chat room in People

1. Click on the IM in the People section of the Messages window.

2. In the IM header, click Create a Chat Room.
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3. Select Private for the Room Type.

4. The Room Name defaults to your display name. If desired, type in a new Room
Name.

5. The person from the one-to-one chat is automatically added to Members.
Start typing the name of another a contact you want to add to the room. As you type
a name, Bria 5 shows a list of suggestions. Select the person you want to invite
from the list.

If you want to remove someone from Members before you create the chat room,
click Remove.

6. Repeat the previous step until all the members you want to add are shown in
Members.

7. If desired, enter a brief Description of the room. This field is optional.

8. Click Create.
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Bria 5 creates the chat room and adds it to the Rooms section of the Messages window.
The Members you invited are automatically added to the room. The lock on the avatar
for the room indicates this is a private chat room.

To create a private chat room in Contacts or Favorites

1. Click a group, or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select two or more contacts, favorites, or groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Create a Chat Room….
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Create a Room opens in the Messages window.

3. Select Private for the Room Type.

4. Room Name defaults to your display name followed by Room. You can edit Room
Name by typing in a new name.

5. The contactsyou selected are listed in Members.

If you want to add any additional , start typing the name of a participant you want to
add to the room. As you type a name, Bria 5 shows a list of suggestions. Select the
person you want to invite from the list.

If you want to remove someone from Members before you create the room, click
Remove.

6. Repeat the previous step until all the members you want to add are shown in
Members.

7. If desired, enter a brief Description of the room. This field is optional.

8. Click Create.
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Bria 5 creates the chat room and adds it to the Rooms section of the Messages window.
The Members you invited are automatically added to the room. The lock on the avatar
for the room indicates this is a private chat room.

Creating public chat rooms

You can create a public chat room from the Messages window, Contacts or Favorites.

To create a public chat room

1. Click + and click Create a room on the Rooms section of the Messages window.
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2. Select Public for the Room Type.

3. Type in a Room Name.

4. If desired, enter a brief Description of the room. This field is optional.

5. Click Create.

Bria 5 creates the chat room and adds it to the Rooms section of the Messages window.
Your can join the room.
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To create a public chat room in People

1. Click on the IM in the People section of the Messages window.

2. In the IM header, click Create a Chat Room.

3. Select Public for the Room Type.

4. The Room Name defaults to your display name. If desired, type in a different
Room Name.

5. If desired, enter a brief Description of the room. This field is optional.

6. Click Create.

Bria 5 creates the chat room and adds it to the Rooms section of the Messages window.
Your can join the room.
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To create a public chat room in Contacts or Favorites

1. Right-click (Windows) or CTRL+click (Mac) on any Contact or Favorite and select
Create a Chat Room….

Create a Room opens in the Messages window.

2. Select Public for the Room Type.

3. The Room Name defaults to your display name. If desired, type in a different
Room Name.

4. If desired, enter a brief description of the room. This field is optional.

5. Click Create.
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Bria 5 creates the chat room and adds it to the Rooms section of the Messages window.
Your can join the room.

Tip: You can select anyContact or Favorite to create a public room. Public rooms are do not
have members so you don't need to select a specificContact or Favorite.

Joining a chat room
There are two types of chat rooms - public and private. Anyone can join a public chat
room. You must be invited to join a private chat room. Bria 5 automatically accepts the
invitation to private chat rooms.

When you join a chat room, you can see the previous messages in the chat room.

Joining a private chat room

In order to join a private chat room, you have to added as a member. You automatically
join the room when the Room Owner invites you and the private room is shown in
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Rooms section of the Messages window with a dot to indicate it is new. If you leave a
private chat room and want to rejoin, you need to be invited to the room again.

Joining a public chat room

You can join existing public chat rooms that were created by one of your .

To join a public chat room

1. Click Join / Create a room and click Join rooms on the Rooms section of the
Messages window.

Bria 5 displays a list of public rooms.

2. Click Join room beside the public room you want to join. If the list of rooms is
long, you can type room name and description keywords in Search.

Click on More Info to view who created the room, when is was created, and the
Description (if one was added).
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3. If you want to join multiple rooms at the same time, click Join room beside all the
public rooms you want to join. Once you have added all the rooms you want to join,
click Close.

The chat room is added to the Rooms section of the Messages window.

Editing chat rooms
After a room has been created, the Room Owner – the person that created the room – can
change the Room Name and Description, add new members, and add a Topic to a
room. These changes are made from the Messages window.

Members of the room can also change the Topic.
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Changing the Room Name and Description

The Room Owner can change the Room Name and Description. The chat rooms you
can edit say Created.

To change the Room Name and Description

1. Click on the room in the Rooms section of the Messages window.

2. In the room header, click Settings.

3. Type a new Room Name or Description.

4. Click Update.
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Bria updates the Room Name and Description.

Adding a Topic to a room

Roommembers can add a Topic for both public and private chat rooms. You might want
to add a Topic to indicate what the current discussion is about. Topics do not show up in
search results.

To add a Topic to a room

1. Click on the chat room in the Rooms section of the Messages window.
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2. Click on Add a topic or on the existing topic.

3. Type in the new Topic.

Bria 5 displays the new topic in the chat room header when the chat room is selected.

Chat room notifications
Bria 5 has several ways to indicate when there is a new message or you have been
mentioned in a chat room you are a member of. You can customize the notifications the
you receive in Preferences >Alerts & Sounds (Windows) or Preferences > Alerts (Mac)
and for each chat room.

Types of notifications

Bria 5 may do the following depending on how you set your Preferences and the
notifications for each chat room:

l Send a notification or open the Messages window when there is a new message if
Notifications is set to All for the chat room.

CounterPath Corporation 106

Bria 5 User Guide Messaging



l Send a notification or opens the Messages window where the user has been
mentioned in a message if Notifications is set to All or to Mentions (@) for the chat
room.

l Cause the icon to flash in the Taskbar or bounce in the Dock when there is a new
message if Notifications is set to All for the chat room.

l Cause the icon to flash in the Taskbar or bounce in the Dock when the user has
been mentioned in message if Notifications is set to Notifications is set to All or to
Mentions (@) for the chat room.

l Display a badge with the number of new messages on the onscreen phone.

l Display a dot beside the chat room in the Rooms list on the Messages window
when there is a new message.
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l Display @ beside the chat rooms in the Rooms list on the Messages window
when the user has been mentioned.

Changing chat room notifications

You can change the notifications you receive for each individual chat room. Choose
from:

l All: Bria 5 notifies you if there is a new message or you have been mentioned in a
chat room you are a member of.

l Mention (@): Bria 5 notifies you if you are mentioned in a chat room you are a
member of.

l None: Bria 5 does not notify you that there is a new message or the you have been
mentioned in a chat room you are a member of.

To change room notifications from the Rooms list

1. Right-click (Windows) or CTRL+click (Mac) on the chat room in the Rooms section
of the Messages window.

2. Select Notifications and the type of notification that you want to receive — All,
Mentions (@), or None.

Bria 5 updates your notification preferences for the room.
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To change room notifications from room options

1. Click on the chat room in the Rooms section of the Messages window.

2. Click More options for this conversation.

3. Select Notifications and the type of notification that you want to receive — All,
Mentions (@), or None.

Bria 5 updates your notification preferences for the room.

Sending and receiving messages

Sending a message

Once you have created or joined a chat room, you can start sending messages.

To send a chat room message

1. Click on the chat room in the Rooms section of the Messages window.

2. Type you message in Compose Message.

3. Click Send Message.

Bria 5 sends the chat room message.
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Receiving a message

Your chat room notification settings determine the type of alert you see when there is a
new message on a chat room.

To view an new message

l Click on the chat room in the Rooms section of the Messages window.

l Click on the notification.

Bria 5 displays the chat room messages.

Mentions

If you want to get the attention of a room member, you can use mentions. The person that
is mentioned sees an indicator beside the chat room in the Rooms section of the
Messages window and sees their name highlighted in the chat room messages.

To mention a person

1. Click on the chat room in the Rooms section of the Messages window.

2. Type @ followed by the name of the person you want to mention in Compose
Message. As you type, Bria 5 offers suggestions. Select the name of the person
from the list of suggestions.

3. Type you message in Compose Message.
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4. Click Send Message.

Bria 5 sends the chat room message. The person mentioned in the message sees an
indicator that they have been mentioned.

Tip: You can use@Everyone to send a mention to all members of a private chat room and all
active members of a public chat room.

Chat room members
Members of a chat room can see who is in the room. The owner of the chat room can
add new members to a private room. The room owner can also re-invite members to a
private chat room.

Seeing who is in a room

As a member of a chat room, you can see who is in the room. Private chat rooms display
everyone who is a member of the chat room along with their status. Public chat rooms
display the room members that are currently online.

To see who is in a chat room

1. Click on the chat room in the Rooms section of the Messages window.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

The members list opens in the chat room panel. Each member of the chat room is
displayed with their status. Hover over the avatar for the members name. Click on the
member to see the contact details.
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Adding new members to a private chat room

The room owner can add new members to a private chat room from the room header or
in the chat room Settings. Once you have invited a person to join the chat room, you
cannot remove a person from the room.

To add new members to a room from the chat room header

1. Click on the chat room in the Rooms section of the Messages window. The chat
rooms you can add members to say Created.

2. Click Add members in the chat room header.

3. Start typing the name of a contact you want to add to the chat room. As you type a
name, Bria 5 shows a list of suggestions. Select the person you want to invite from
the list.
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4. Click Add members to add the contact. Click Cancel if you do not want to add
the contact.

Bria 5 adds the contact to the chat room.

To add new members to a room from chat room Settings

1. Click on the chat room in the Rooms section of the Messages window. The chat
rooms you can add members to say Created.

2. In the room header, click Settings.

3. Start typing the name of a contact you want to add to the chat room in Add
recipients. As you type a name, Bria 5 shows a list of suggestions. Select the
person you want to invite from the list.

4. Click Update.
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Bria 5 adds the contact to the chat room.

Re-inviting a member

If the owner of the chat room sends an invitation to someone who is using a version of
Bria 5 that does not support chat rooms, the member may not automatically join the chat
room. Once they have upgraded their version of Bria 5, the room owner can re-invite the
member.

To re-invite a member

1. Click on the chat room in the Rooms section of the Messages window.

2. Click Members in the chat room header. The number indicates the number of
members in the room.
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3. Right-click (Windows) or CTRL+click (Mac) on the member and click Resend
invitation.

The Member you re-invited is automatically added to the room.

Leaving or deleting a chat room
You can leave a private or public chat room without closing it if you are not the room
owner. If you are the room owner, you can delete a private or a public chat room.

Tip: Before you leave or delete a room, you may want to export the conversation.

Leaving a chat room

If you are not the room owner, you can leave a chat room from the Rooms list or from the
chat room header.

To leave a room from the Rooms list

1. Hover on the chat room in Rooms.

2. Click Leave Room.
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The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.

To leave a room using the chat room shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the chat room in Rooms.

2. Click Leave Room.

The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.

To leave a chat room using the room options

1. Click on the chat room in Rooms.

2. Click More options for this conversation.

3. Click Leave Room.
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The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.

Deleting a chat room

If you are a room owner, you can delete both public and private chat rooms. If you delete
the room, it is no longer available for other room members.

To delete a room from the Rooms list

1. Hover on the chat room in Rooms.

2. Click Delete Room.

The chat room is deleted and removed from the Rooms list.

To delete a room using the chat room shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the chat room in Rooms.

2. Click Delete Room.

The chat room is deleted and removed from the Rooms list.

To delete a chat room using the room options

1. Click on the chat room in Rooms.

2. Click More options for this conversation.
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3. Click Delete Room.

The chat room is deleted and removed from the Rooms list.

The room owner deletes a chat room

The room owner may delete a chat room that you are a member of. If this happens, the
chat room remains in Rooms but is dimmed and shows a message that the room is
closed.

To remove the chat room from Rooms, leave the room using one of the methods above.
In addition to the above methods, you can leave from the chat room messages panel. If
you want to keep the message history, export the conversation before you leave the
room.

To leave a closed chat room

1. Click on the chat room in Rooms.

2. Click Leave in the messages.
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The chat room is deleted and removed from the Rooms list.

Working with messages
Bria 5 allows you to preview hyperlinks, search, copy/paste, export, and delete
messages and conversations.

Previewing hyperlinks
When you send or receive a message with a hyperlink in it, Bria 5 can show a preview of
the hyperlink in the message.

To control hyperlink previews

1. Click Preferences on the Softphone menu (Windows) or the Bria 5 menu (Mac).

2. Select or clear Show hyperlink preview on messages.

Bria 5 either shows or removes previews for all the hyperlinks in Messages.

Search messages
You can use the search feature to find a message in an IM or group chat using a Room
Name, name or a keyword.
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To search in messages

1. Type the Room Name, contacts name or search keywords in the Search
Messages field. Bria 5 filters the sessions that contain the search words.

Bria 5 displays the chat room an IMs that contain the search word.

2. Click the chat room or instant message you want to view.

Bria 5 displays the messages in the chat room or IM that contain the name or
keyword. Bria 5 displays the entire chat room when Room Name was used as the
search word.

The session appears in the Messages pane.

Copying and pasting messages
You can copy messages from Bria 5 and paste within the Bria 5 or in another
application.

To copy and paste messages

1. In the Messages window, highlight the message or messages that you want to
copy.

2. Windows: Right-click one of the selected messages and click Copy or press
CTRL+C on the keyboard.

Mac: COMMAND+ click on one of the selected messages and click Copy or press
COMMAND+C on the keyboard.
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Bria 5 places the messages on the clipboard. You can paste the messages in Bria 5 or
in another app on your computer.

Exporting messages
You can export instant messages and chat room messages into a CSV file.

Tip:When you close or leave a chat room, you no longer have the conversation history. If you
want to keep the messages, export them first.

To export a conversation using the More menu

1. Click More options for this contact, More options for this conversation
(Windows) or More options for this conversation (Mac), and then click Export
Conversation.

Bria 5 opens the File Manager.
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2. Select the location and enter a name for the file. Click Save.

Bria 5 saves the session as a .csv file in the location you selected.

To export a conversation using the shortcut menu

1. Right-click on the IM or chat room and click Export Conversation.

Bria 5 opens the File Manager.

2. Select the location and enter a name for the file. Click Save.
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Bria 5 saves the session as a .csv file in the location you selected.
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Presence

Bria 5 allows you to share your online status (your presence) with contacts who have a
softphone number or an XMPP address. When you launch Bria 5, your online status is
Available.

You can view the status of contacts who have a softphone number or an XMPP address
if they choose to share their status with you.

Changing your status
Bria 5 allows you to share your online status (your presence) with contacts who have a
softphone number or an XMPP address. When you launch Bria 5, your online status is
Available.

You can change your status from Available to Busy, Away, Not available for call, Do not
disturb, and Appear offline. When you change your status from Available, Bria 5 no
longer automatically updates your status and it remains as what you set it to until you
change it again.

Bria 5 updates your status to On the phone when you make or receive a phone call if
your status is Available. If you do not use your computer for a specified period of time
(set in Preferences: Application panel), Bria 5 updates your status to Idle.

Note: Tomake use of presence on a SIP account, make sure that your VoIP provider supports
SIP SIMPLE.

To change your status

1. Click the drop-down arrow beside your online status indicator.
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2. Select the status you want to display.

Bria 5 updates your status. If you change your status away from Available, Bria 5 does
not automatically update your presence.

Status indicators and what they mean

Icon Status Meaning for your status Meaning for others’ status

Available Either:

l You have set your status to this value.

l Bria 5 hasdetermined that you are logged on but not on
the phone or idle.

When you have this status, Bria 5 automatically detectswhen
you are idle or on the phone, and changes the status tomatch.

You can contact this person.

Busy You have set your status to this value. Bria 5 never automatically
switches you out of this status; youmust switch yourself.

You can contact this person.

Away You have set your status to this value. Bria 5 never automatically
switches you out of this status; youmust switch yourself.

You can contact this person.

On the
phone

Either:

l You have set your status to this value. In this case, Bria
5 never automatically switches you out of this status;
youmust switch yourself.

l You started a phone callwhen your statuswas
Available.When your call ends, your status reverts
back to Available.

You can contact this person.
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Do not
disturb

You have set your status to this value. Bria 5 never automatically
switches you out of this status; youmust switch yourself.

You cannot contact this person.

Not
available
for calls

You have set your status to this value. Bria 5 never automatically
switches you out of this status; youmust switch yourself.

You cannot contact this person.

Idle You have not moved or clicked themouse or pressed a
keyboard key for the idle period. Set the idle period in
Preferences: Application panel.

As soon as you click themouse or keyboard, your status
changes to Available.

You can contact this person.

Appear
offline

You have set your status to this value. The other person sees
you asoffline, even though you are actually online. The other
person cannot tell the difference between this statusand you
really being offline.

You see the statusOffline for this
contact. You cannot tell the difference
between this statusand if the contact is
really offline.

Offline This status if automatically set byBria 5 when you are not signed
in.

The contact is either not logged in or
doesnot want to share online status.

n/a No icon Not applicable You are not watching the other
person’s status.

Settings your custom status
You can create a custom wording for your presence status. When you set a custom
status, Bria 5 does not automatically update your status for you.

To change your custom status

1. Click on the wording in the status indicator and type your custom status. Press
ENTER when you finished.

Bria 5 updates your custom status.
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To remove your custom status

1. Click on the wording in the status indicator, delete all text, and press ENTER.

Bria 5 returns to the default status wording.

Viewing others’ status and status alerts
To view the status of your contacts, contacts must be tagged for presence. The way to
tag a contact for presence depends on the way they were added to contacts.

If you create contacts by importing a contact list, you can specify whether you want to
see presence during the import. See Contacts for more information.

To view contact status in Contact Profile

To view the status of your contact when you added created them manually in the
Contact Profile (Windows) or the Contact Editor (Mac), you need to include the method
for viewing their presence in their contact profile.

If the contact is using SIP for presence, you need to add their SIP address to the
Softphone field. Bria 5 automatically obtains the status information for this address.

If the contact is using XMPP for presence, you need to add their XMPP address to the
Instant Message field. The contact is sent a presence request. You only see their status
if they accept your request.

To enable contact presence in your XMPP account

When you add an address to the Instant Message field for a contact, you can choose to
enable presence. If you select Enable presence, Bria 5 sends a request to the contact. If
the person allows this request, their status appears in contacts.
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If you did not select Enable presence when you added an address to the Instant
Message field, you can edit the contact, select the Instant Message contact method, and
click Enable XMPP Presence.

If you are using an XMPP account independent of Bria 5, XMPP contacts connected to
your external XMPP account are automatically pulled into the List of contacts and are
set to share status information.

To enable presence for Windows Outlook account contacts

If you created an Outlook account on Bria 5, you need to set up mapping to view
presence for your Outlook contacts.

1. Click Account Settings on the Softphone menu.

2. Select your Outlook account and click Edit.

3. In Account Details, set Field to use for Softphone address to the field you use in
Outlook to enter SIP addresses.

In order for a contact to show a presence icon, they must be presence ready — they must
have an address that allows for presence data to be shared — and you must be
subscribed to the contact.

To make use of presence on a SIP account, make sure that your VoIP provider supports
SIP SIMPLE.

Account
type

Presence ready

A contact is “presence ready” if:

No presence icon

If the contact is “presence ready” and the presence icon still
doesnot show:

SIP The contact hasan address in the Softphone field. Go to Softphone >Account Settings, select your SIP
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If SIP addressesare not appearing in the Softphone field
after importing a file, the easiest solution is to fix the file and
redo the import.

account, and clickEdit. Make sure that Allow this account
for IM / Presence is selected.

XMPP The contact hasa Jabber address in the Instant Message
field.

Make sure the XMPPaccount is enabled.

Make sure you selected Enable Presence in the IM
introduction.

Outlook Your Outlookaccount has the Field to use for Softphone
address set to the field you are using for softphones in
your Outlook contacts.

Bria 5 recognizes theOutlook contact field as containing a
SIP address: an address that can be used for a phone call,
an IM, and presence via a SIP account.

Go to Softphone >Account Settings, select your SIP
account, and clickEdit. Make sure that Allow this account
for IM / Presence is selected.

Go to Softphone >Account Settings, select your Outlook
account, and clickEdit. Make sure Field to use for
Softphone address is set to the correct Outlook field.

To enable presence for Mac Address Book account contacts

A Mac Address Book account is automatically created in Bria 5. You can enable or
disable the Mac Address Book by selecting or clearing the check box in the Enabled
column.

If your Mac address book contains phone numbers that you know you can use to obtain
online availability information about a contact through your SIP account, you can
subscribe to their status in Bria 5.

To respond to an online status request

Someone who is not one of your contacts may add you as a contact on their end. If they
include your softphone number or your XMPP address, you will receive an Online
Status Request.
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You can respond to the request by clicking Allow or Ignore.

Allow: The person is added to the List of contacts. You can edit the Display
as field and the Group for this person. Once you click Allow, Bria 5
automatically sends a request back to the person.

Ignore: The other person will not be able to see your online status. The
Online Status Request may appear again in this session or a future session.

Online status alerts
You can add and remove contacts, favorites, or group of contacts to the alert list. When a
contact is on the alert list, you receive a Bria 5 notification when their online status has
changed.

To add contacts or favorites to the alert list

1. Click on a contact or favorite, or use SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) or a combination to select one or more contacts or favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add to Alert List (Windows)
or Add Contact to Alert List (Mac).

An alert icon appears by the contact after you add them to the alert list. The icon
disappears when you remove the contact from the alert list.

To add groups to the alert list

1. Click on a group or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Add Group to Alert List
(Windows) or Add Contacts in Group to Alert List (Mac).

Bria 5 adds the contacts in the group to the alert list. An alert icon appears by the
contacts in the group.
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To remove contacts or favorites from the alert list

1. Click on a contact or favorite, or use SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) or a combination to select one or more contacts or favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove from Alert List
(Windows) or Remove Contact from Alert List (Mac).

Bria 5 removes the contacts or favorites from the alert list. The alert icon disappears from
the contacts.

To remove groups from the alert list

1. Click on a group or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove Group from Alert
List (Windows) or Remove Contacts in Group from Alert List (Mac)

Bria 5 removes the groups from the alert list. The alert icon disappears from the contacts.

Alert styles

Windows

You will receive a notification when the contact changes their status. On Windows 7
alerts, select Keep contact on Alert List if you want to continue to see presence changes.
On Windows 10 toast notifications, click Remove Alert to stop seeing presence changes
for the contact. You can call or IM the contact directly from both alert styles.
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Mac

Banner style notifications appear briefly in the top corner of the screen. They will
disappear on their own. Alert styles notifications appear and remain on the screen until
you take action on them. Click the notification to bring Bria 5 into the foreground.
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File sharing

Send and receive files with Bria 5 from your XMPP account to a contact that has an
XMPP account. To use XMPP file transfer, both the sender and receiver need to
subscribe to each other's contact presence using XMPP, and the recipient needs to have
their XMPP account enabled.

Sending files
You can send a file:

l Using the shortcut menu

l By dragging a file to an IM session

To send a file using the shortcut menu

You can use the shortcut menu to send files from the Messages window, contacts, and
favorites.

1. Right-click (Windows) or CTRL+Click (Mac) on a contact or favorite and click Send
Files. The file manager opens.
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2. Find the file you want to send. Double-click the file or click the file and click Open.

A File Transfer (Windows) or a Send files to: Recipient (Mac) dialog opens. Bria 5 waits
for the recipient to accept the file transfer. If you want to cancel the transfer, click Cancel
before the recipient accepts.

To send a file by dragging it to an IM session

1. Open your file manager and locate the file you want to transfer.

2. Drag the file into an IM session on the Messages window.

A File Transfer (Windows) or a Send files to: Recipient (Mac) dialog opens. Bria 5 waits
for the recipient to accept the file transfer. If you want to cancel the transfer, click Cancel
before the recipient accepts.
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Receiving files
If you have an XMPP account enabled, another person with an XMPP account can send
you files. The following dialog appears when the other party initiates the transfer. Click
Save and set the location to save the file.
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Contacts

Bria 5 stores your contacts for you. These contacts may be contacts you have added
using Bria 5, they can be contacts that are synched with your Outlook , or they can be
special Bria 5 contacts known as Buddies – contacts who share their presence with you.

Contacts are organized in groups in List of contacts (Windows) or Contacts (Mac) —
referred to as Contacts. The Contacts tab is empty at start-up. Each contact is shown
with presence information (if available) and icons for single-click calling and messaging.

If you have contacts that you use frequently, you can add these contacts as Favorites for
easier access.

If the Contacts or Favorites tabs are not showing, click Show Contacts or Show
Favorites on the View menu.

Viewing contacts
You can view a contact from the Contacts, Favorites or History tab.

Using Contacts and Favorites
In Contacts or Favorites, you can open the Contact Info flyout, or open the Contact
Profile (Windows) or the Contact Editor (Mac) for more contact details.

Using the Contact Info flyout

1. Click on a contact in Contacts or Favorites. A Contact Info flyout appears with
contact information.

2. Click Profile if you want to see more information.
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Bria 5 displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact in Contacts or Favorites
and select Edit Profile (Windows) or View/Edit Profile (Mac).

Bria 5 displays the Contact Profile.

Using History
In History, you can open the Contact Info flyout, or open the Contact Profile (Windows)
or the Contact Editor (Mac) for more contact details.

Using the Contact Info flyout

1. Click on a History group to expand the group entry.
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2. Click on Contact Info. A Contact Info flyout appears with contact information.

3. Click Profile if you want to see more information.

Bria 5 displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Edit Contact.

Bria 5 displays the Contact Profile (Windows) or the Contact Editor (Mac).
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Adding and exporting contacts
For each contact you communicate with, you can save their information as an entry in
the contacts list. These contacts are added individually or by importing multiple contacts
from another source. You can also export your contacts to a .csv file, a vCard file, or a
.pst file.

When you first deploy Bria 5, and at any time in the future, you may want to populate the
contacts from an external source such as a file of contacts in your Outlook address book.

You can populate the contacts in these ways:

By entering contact information

By importing contacts

From an XMPP account

From LDAP or Active Directory

Windows: From your Microsoft Outlook account

Adding an individual contact
You can add contacts individually in the Contacts panel, using the Contacts menu and
in the History panel. For information on populating contacts, see Adding and exporting
contacts.

Adding a contact in the Contacts panel

Use Add a new contact or the shortcut menu to add an individual contact from the
Contacts panel.

To add a contact using the Add a new contact icon

1. On the Contacts panel, click Add a new contact.
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The Contact Profile (Windows) or the Contact Editor (Mac) window appears.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

3. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

4. Complete the Display name (required on Windows).

5. Complete any other fields you want to include with the contact.

CounterPath Corporation 140

Bria 5 User Guide Contacts



6. Click OK.

The contact is added to the Bria 5.

To add a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a group and click Add Contact to
Group. The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.
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3. Complete the Display name (required on Windows).

4. Complete any other fields you want to include with the contact.

5. Click OK.

The contact is added to the Bria 5.

Adding a contact using the Contacts menu

You can add contacts to Bria 5 using the Contacts menu on the menu bar.

To add a contact using the Contacts menu

1. Click Add Contact on the Contacts menu.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.
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3. Complete the Display name (required on Windows).

4. Complete any other fields you want to include with the contact.

5. Click OK.

The contact is added to the Bria 5.

Adding a contact in the History panel

Add an unknown caller to Contacts from History using Add this person to your
contact list or using the shortcut menu.

To add a contact using the Add this person to your contact list icon

1. Click on a History group with the caller ID Unknown. The History group expands.

2. Click Add this person to your contact list.

The Contact Profile (Windows) or the Contact Editor (Mac) opens.

3. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.
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4. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

5. Complete the Display name (required on Windows) and any other fields you want
to include with the contact.

6. Click OK.

The contact is added to the Bria 5.
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To add a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the History entry with the caller ID
Unknown and click Add to Contacts.

The Contact Profile (Windows) or the Contact Editor (Mac) opens.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

3. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.
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4. Complete the Display name(required on Windows) and any other fields you want
to include with the contact.

5. Click OK.

The contact is added to the Bria 5.

Fields in Contact Profile

The Contact Profile is divided into Contact Summary, Contact, and XMPP. The XMPP
section does not show until you add the XMPP account to the Instant Message contact
information type. If you have merged multiple contacts together, you may see more than
one Contact and XMPP section.

Some fields may be read-only depending on how the contact was added to Bria 5.

This following is a list of Bria 5 contact fields and their description:

Contact summary

l Contact image: The image associated with the contact. If the contact has more
than one image, use the drop-down to choose the image that you want to use. You
can also use the drop-down to Change or Reset the image.

l Display as: This field only shows if there are more than one Display name is
available for this contact. If several display names are available, choose the one
that you want to show in the contact list.

l Group: Click the drop-down list and select each group the contact is going to
belong to. A contact must belong to one group and can belong to multiple groups.
See Managing groups for more information.

l Primary presence: This field is read-only unless a contact has both a softphone
and an XMPP address. If the contact has more than one softphone address that
supports presence, use the Presence field in the Contact section to choose which
address to use. Primary presence is used for:

l The presence icon on the contact list that shows the status for this address.

l The single-click and double-click actions for instant messaging.

You can still send IMs to this person at their other addresses by using right-click
(Windows) or CONTROL+Click (Mac) and choosing them from the shortcut menu.
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l Primary Call (Mac): This field is read-only unless the contact has more than one
phone number. Primary Call is used with single-click calling and double-click
calling.

l Primary phone number (Windows): This field is ready-only unless the contact has
more than one phone number. The Primary phone number is used with single-
click calling and double-click calling.

Contact

Display name (required on Windows): The display name is the source of
information.

First name, Last name (Optional): A first name and a last name for the
contact.

Contact Methods: The drop-down list that contains the different methods of
contacts.

Enter the person's IM address as follows:

l Choose Instant Message if you are using an XMPP account for
messaging and presence.

Presence: This field is automatically populated when you enter and address
in the Softphone or Instant Message contact method. It indicates that you
are sharing presence information using this address. The address is shown
in the list in the Primary presence field.

XMPP

Display name: The display name is the source of information.

First name, Last name (Optional): A first name and a last name for the
contact.

Contact Methods: This section is read-only. The contact information that is
associated with the Skype for Business contact displays here.

Privacy relationship: The relationship you want to associate with the Skype
for Business contact. This field determines what information the Skype for
Business contact can see about you.
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Importing contacts
You can populate Bria 5’s contacts by importing an external file or files. Your system
administrator may have placed a file on the server for you to import. You can also import
your own file or files. New contacts will be added to existing contacts.

You can import a contact list from:

l .csv file: A comma-separated value file. Use this method to import from a
Microsoft® Excel® file.

l vCard file (*.vcf file): A vCard is an electronic business card that is often attached
to an e-mail.

l .pst file: (Windows) A Microsoft Exchange® contact list (*.pst file).

l Mac Address Book: (Mac) A Mac contact list.

To prepare a CSV file in Excel for import

1. Remove any introductory text or headings from the to of the file. You can keep the
text at the end of the file as it will be ignored during import.

2. Insert a blank row as the first row. In the next row, insert the heading that Bria 5 will
use to interpret the meaning of each column. The columns can be in any order.
The key heading are:

l sip-address: Bria 5 recognizes a value in this column as a softphone address
and considers the address as one that can be phoned and one that can be
using for IM and presence (if SIP is being used for IM and presence).

l xmpp-address: Bria 5 recognizes a value in this column as a Jabber (XMPP)
address and will map this field to the Instant Message field for the contact.

l display-name, given-name, and surname

l business_number

l presence_subscription: Complete this field in one of these ways:
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If you only want to share presence information with some of your contacts, fill
in this column in the file. Enter "true" for contacts whose online presence you
want to see. Leave this column blank or enter "false" for others. During the
import, you will be able to choose to share presence with only the contacts
that have "true". Bria 5 will subscribe to the presence for "true" contacts
assuming that the user has a SIP account (if SIP is being used for IM and
presence).

If you want to share presence with all or with none of your contacts, ignore
this heading. During the import you will be able to choose whether to share
will all or none of your contacts.

For a complete list of headings, see Contact list headings.

3. Save the file as "*.csv".

The file is now ready for import.

To import contacts from a .pst, .csv, or vCard file

1. On the Contacts menu, click Import Contacts.

2. Select the file type — Comma-separated values (*.csv file), vCard (*.vcf file), or
Outlook or Exchange server (Windows only) — and click Next.

3. Enter the location of the file and click Next.

4. Set the Contact Options and the Presence options for all imported contacts and
click Next.
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Bria 5 imports the contacts that are in the file.

To import Mac address book contacts

1. On the Contacts menu, select Import Contacts.

2. Use the drop-down list to select Mac address book in the Import from field and
leave Location blank.

3. Set the Contact Options and the Presence options for all imported contacts and
click Start import.

4. Select the individual contacts you want to import or select the check box for Select
all contacts.

5. Click Import.

Bria 5 imports the contacts that are in the file.
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Exporting contacts
You can export Bria 5 contacts to a file on your computer.

Windows

In Windows, Bria 5 contacts can be exported as a .csv file, a vCard file, or a .pst file.

To export a .csv file

1. On the Contacts menu, click Export Contacts.

2. Select Comma-separated value (*.csv file) from the drop-down list and click Next.

3. Click Browse.

The Windows save dialog open.

4. Use the file explorer to find the location you want to save the file, give the file a
name and click Save.

5. Click Next on Export Contacts.

A new .csv file is created in the location you chose in the Export Contacts wizard.

l PST: For a PST export, the existing PST file is updated to include the entries from
Bria 5. If Microsoft® Outlook® is open, the entries immediately appear in the
Outlook contacts.

All information in Bria 5 is exported to Microsoft Outlook. Only information that can
be displayed in Outlook appears in the Outlook Contacts window. Typically, this
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means that all softphone addresses are exported (and stored in custom fields) but
not displayed in Outlook.

l vCard and CSV: A new file of the specified type is created in the location you
chose in the Export Contacts wizard.

To export a .vCard file

1. On the Contacts menu, click Export Contacts.

2. Select vCard (*.vcf file) from the drop-down list and click Next.

3. Click Browse. The Browse For Folder dialog opens.

4. Use Browse For Folder to navigate to the location you want to save the file and
click OK.

5. Click Next on Export Contacts.

A new vCard file is created in the location you chose in the Export Contacts wizard.

To export a .pst file

1. On the Contacts menu, click Export Contacts.

2. Select Outlook or Exchange server from the drop-down list and click Next.
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3. Click Browse.

The Windows save dialog open.

4. Use the file explorer to find the location you want to save the file, give the file a
name and click Save.

5. Use the drop down list to select a field to use in the .pst file for the softphone
address and the IM address.

6. Click Next.

The existing PST file is updated to include the entries from Bria 5. If Microsoft® Outlook®

is open, the entries immediately appear in the Outlook contacts. Typically, this means
that all softphone addresses are exported (and stored in custom fields) but not displayed
in Outlook.

Mac

In Mac, Bria 5 contacts can be exported as a .csv file or a vCard file.

To export a .csv file

1. On the Contacts menu, click Export Contacts.

2. Select Comma separated values (*.csv file) from the drop-down list.

3. Type a name for the file in Save as.

4. Use Browse to select the location you want to export the file to.
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5. Click Export.

A new file of the specified type is created in the location you chose in the Export
Contacts wizard.

To export a vCard file

1. On the Contacts menu, click Export Contacts.

2. Select vCard (*.vcf file) from the drop-down list.

3. Use Browse to select the location you want to export the file to.

4. Click Export.

A new file of the specified type is created in the location you chose in the Export
Contacts wizard.

Editing a contact
You can update contact information, merge and split contacts, change the contact
groups, and delete contacts.

Updating contact information
You can open the Contact Profile (Windows) or the Contact Editor (Mac) from Contacts,
Favorites, or History. Once in the Contact Profile (Windows) or the Contact Editor
(Mac), you can edit the contact.
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Using Contacts and Favorites

In Contacts and Favorites, you can use the Contact Info flyout or the shortcut menu to
open the Contact Profile (Windows) or the Contact Editor (Mac) so you can edit
contacts.

To edit a contact using the Contact Info flyout

1. Click on a contact and click Profile in the Contact Info flyout.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Edit any of the fields that need to be changed.

3. Click OK.

The contact is updated in Bria 5. If you add or edit the Softphone or Instant Message
contact method, an online status request is sent to this person.

To edit a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
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(Windows) or View/Edit Profile (Mac).

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Edit any of the fields that need to be changed.

3. Click OK.

The contact is updated in Bria 5. If you add or edit the Softphone or Instant Message
contact method, an online status request is sent to this person.

Using History

In History, you can use the Contact Info flyout or the shortcut menu to open the Contact
Profile (Windows) or the Contact Editor (Mac) so you can edit contacts.
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To edit a contact using the Contact Info flyout

1. Click on a History group to expand the group entry.

2. Click on Contact Info. A Contact Info flyout appears with contact information.

3. Click Profile.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

4. Edit any of the fields that need to be changed.

5. Click OK.

The contact is updated in Bria 5. If you add or edit the Softphone or Instant Message
contact method, an online status request is sent to this person.
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To edit a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Edit Contact.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

3. Edit any of the fields that need to be changed.

4. Click OK.

The contact is updated in Bria 5. If you add or edit the Softphone or Instant Message
contact method, an online status request is sent to this person.

Merging contacts
If you have two entries that should be one contact, you can merge the contacts together.

To merge contacts using the shortcut menu

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a
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combination to select one or more contacts you want to merge.

2. Right-click (Windows) or SHIFT+CTRL+Click (Mac) and select Merge Contacts.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

3. Edit any of the fields that need to be changed.

4. Click OK.

The contacts are merged into a single contact. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.

To merge contacts using drag and drop

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a
combination to select all but one of the contacts you want to merge.

2. Drag the selected contacts onto the last contact you want to merge. The Merge
Contacts dialog opens.
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The Merge Contacts dialog opens.

3. Click Yes on the Merge Contacts pop-up.

The Contact Profile (Windows) or the Contact Editor (Mac)window opens.

4. Edit any of the fields that need to be changed.

5. Click OK.

The contacts are merged into a single contact. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.

Splitting contacts
If you want to separate a merged contact back into separate contacts, you can split the
contact.

CounterPath Corporation 160

Bria 5 User Guide Contacts



To split contacts using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact and click Split Contact.

Bria 5 splits that contact into the original contacts.

To split a contact using the Contact Profile

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).
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The Contact Profile (Windows) or the Contact Editor (Mac) opens.

2. Click Split Contact.

The contact is splits into the original contacts.

Changing contact groups
You can move a contact from one group to another or add them to multiple groups.

To move contacts to another group

1. In the contacts panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more contacts you want to move to another
group.

2. Drag the selected contacts to the title bar of the new group.
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The contact or contacts are removed from the old group and added to the new group.

To add and remove contacts from multiple groups using the Contact Profile

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Click the drop-down arrow in Group. Select the groups you want to add the contact
to and deselect the groups you want to remove the contact from.
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3. Click OK.

The contact is added to all groups you selected and removed from all groups you
deselected.

To remove a contact from a single group

If a contact is in multiple groups, you can remove them from one of the groups.

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a
combination to select one or more contacts you want to remove from a group. Make
sure you select the contact or contacts in the group you want to delete them from.

2. Right-click (Windows) or CTRL+click (Mac) and click Delete Contact for an
individual contact or Delete Selected for multiple contacts.

3. If the contact belongs to more than one group, clear Delete this contact from all
groups or Delete these contacts from all groups. Click Yes in the Delete Contact
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dialog.

The contact or contacts are removed from the group. They remain in any other groups
they belonged to.

Deleting a contact
You can delete a single contact or a group of contacts from Bria 5.

To delete one or more contacts

1. In the contact panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac), or any combination to select the contacts you want to delete.

2. Right-click (Windows) or CTRL+click (Mac) and select Delete Contact or Delete
Selected.

3. If the contact belongs to more than one group, leave Delete this contact from all
groups or Delete these contacts from all groups selected. Click Yes.

The contacts are deleted.
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Managing groups
Contacts are arranged in groups. Bria 5 has three default groups: Family, Friends, and
Work.

Each contact must belong to at least one group and can belong to multiple groups. You
can create, rename, and delete groups.

As well as organizing your contacts, you can perform the following actions on groups
instead of on individual contacts:

Create a chat room

Add a group to the alert list

Add a group to Favorites

Creating a group
Use the shortcut menu or the Contacts menu to create a new group.

To create a new group using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a group in contacts from the shortcut
menu.

2. Type in a group name in the New Group window and click OK.
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The new Group is displayed in the List of contacts.

To create a new group using the Contacts menu

1. Click New Group on the Contacts menu.

2. Type in a group name in the New Group window and click OK.

The new Group is displayed in Contacts.

Renaming a group

To rename a group using the shortcut menu

1. Right-click on a group in Contacts and select Rename Group.
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2. Type in a the new group name in the Rename Group window and click OK.

The Group appears with the new name in the List of contacts.

Deleting groups

To delete a group

1. Right-click (Windows) or CTRL+click (Mac) on a group in contacts and select
Delete Group.

2. If there are contacts in the group, click Yes in Delete Group.
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The Group is deleted from contacts. Any contacts that were not in another group are
deleted.

Favorites
You can create favorites from the Contacts panel or in the contact profile. When you add
a contact to Favorites, it displays in both the Contacts panel and the Favorites panel.
Adding contacts to Favorites makes it easier to find contacts that you use frequently.

Adding a contact to Favorites
You can add a contact to Favorites using the shortcut menu.

To add a contact to Favorites

1. Click on a contact or SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
on one or more contacts you want to add to Favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add to Favorites.

The contact or contacts are added to Favorites.

Adding a group to Favorites
You can add a group to Favorites using the shortcut menu.
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To add a group to Favorites

1. Click on a contact, SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
one or more contacts you want to add to Favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add Group to Favorites
(Windows) or Add Contacts in Group to Favorites (Mac).

The contacts in the group or groups appears are added to Favorites and can be viewed
in the Favorites panel.

Removing a contact from Favorites
You can remove a contact from Favorites panel using the shortcut menu.

To remove a contact from Favorites

1. On the Favorites panel, click on a contact, or SHIFT+Click, CTRL+Click
(Windows), COMMAND+Click (Mac) one or more contacts you want to remove from
favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove from Favorites.
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The contact or contacts are removed from the Favorites panel but still appear in the
Contacts panel.

Warning: If you selectDelete Contact, the contact is deleted from Bria 5, not just from
Favorites.

Directory Tab
The Directory tab is only available if your system administrator has set up Bria 5 to
access a corporate directory. Only one phone number appears for each entry. More
numbers may show on the shortcut menu for the contact.

To view the Directory tab, click Show Directory on the View menu.

To phone a directory contact

Right-click (Windows) or CTRL+click (Mac) on an entry and choose Call or Video Call
from the shortcut menu. If there is more than one number for the person, click on the
number that you want to use.

To create a contact from the directory

1. Right-click (Windows) or CTRL+click (Mac) on an entry and choose Add as
Contact. The Contact Profile (Windows) or Contact Editor (Mac) window appears
with all the information from the directory populated.
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2. Complete any of the fields that are missing information you want to add to the
contact and click OK.

The person is added to contacts.

When a contact is created from the directory, the contact is:

l Automatically updated whenever the corresponding directory entry changes.

l Automatically deleted if the corresponding directory entry is deleted.

Note: Contacts created from directory entries do not show presence when you are using SIP
SIMPLE for presence as opposed to XMPP and when contacts are created from an LDAP or
Active Directory. If you create the contacts manually in the contacts panel, presence will display
properly.

To delete a directory contact

A contact created from the directory can be deleted from Contacts.

1. In the contact panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac), or any combination to select the directory contacts you want to delete.

2. Right-click (Windows) or CTRL+click (Mac) and select Delete Contact or Delete
Selected.

3. If the contact belongs to more than one group, leave Delete this contact from all
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groups or Delete these contacts from all groups selected. Click Yes.

The person is deleted from Contacts. The person is not deleted from the Directory.
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History

All Bria 5 calls are captured in the Bria 5's List of recent calls (Windows) or History
(Mac) – referred to as History. The last 200 records are stored in Bria 5 and grouped by
phone number.

Recordings are stored in History and can be played back or deleted right from Bria 5.

Viewing History
All Bria 5 calls are captured in Bria 5's List of recent calls (Windows) or History (Mac) –
referred to as History. Calls are grouped to easily find all calls from one contact, and can
be filtered to make it easier to find a specific call. Recordings are captured in history –
listen to, share, or delete recordings directly from history.

Call grouping
Calls captured in Bria 5's history are grouped by name and caller ID. The caller ID can
be a phone number or a SIP address, but will be referred to as phone number. The
group can be expanded and collapsed to show or hide the individual calls in the group.

If a person has called you from multiple numbers, you may see more than one group of
calls for them.

Collapsed group display

The collapsed group displays an overview of call information: the name and presence
status of the caller, the number and types of calls, and the time and date of the most
recent call.
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Expanded group display

The expanded group shows a list of recent calls between you and the person. The most
recent calls are displayed at the top of the list. In addition to the information displayed in
the collapsed group, Bria 5 also shows whether the call was voice or video, the time and
date, and the length of the call.

Multiple groups for the same number

In some cases, calls from the same person may show up in multiple groups. If one call
only contains the phone number, and another call contains the phone number with a
domain, they calls appear in two different groups. Bria 5 does not strip the domain and
try to match the results with other calls.

Multiple contacts with the same number

When you have a number that is used for multiple contacts, all calls for that number are
grouped together as Multiple Contacts. Expand the group and click Contact Info to
see the contacts associated with the number.
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Unknown contacts

There are two types of unknown contacts that can appear in the call history. If a call
comes from a phone number that is not in your contacts, the contact is grouped as
Unknown with the phone number displayed. Calls that come in with an unknown number
are grouped as Unknown with Unknown displayed for the number.

To view all calls in a group

1. Click the group you want to expand.

Bria 5 displays the expanded group.

Call type icons and their meanings
Incoming call

Outgoing call

Incoming call with a call recording

Outgoing call with a call recording

Missed call

Filtering call history
Limit the calls you see in the call history using filtering. Bria 5 lets you filter all calls,
missed calls, calls with recordings, and calls by date.
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Filtering for missed calls

You can filter call history for all missed calls or filter for missed calls on a specific
account if you have more than one account.

To filter missed calls

1. Click on the call filter and click Missed Calls.

2. Click All or click the account you want to see missed calls from if you have more
than one SIP account.

Bria 5 displays all missed calls or the missed calls for the selected account.

You can filter which calls you see in Bria 5's History.

Filtering for recordings

If you are searching for a call recording, you can filter the call history to show only calls
that have recordings.
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To filter for recordings

1. Click on the call filter and click Recordings.

Bria 5 displays all calls that have a recording associated with them.

Filtering by date

You can search Bria 5 for calls based on when the call occurred. Filter calls from Today,
Yesterday, This Week, This Month, Last 7 Days, and Last 30 Days. This Week filters for
calls for the current week running from Sunday to Saturday. This Month filters for calls
during the current calendar month.

To filter by date

1. Click on the call filter and click Date.

2. Click the selector for the dates you want to filter.
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Bria 5 displays all calls that match the date selector.

To see which filter is applied to call history when the full name of the
filter does not fit, hover over the filter drop down and the full text
appears.

Searching and filtering History
To find a specific entry in History, you can filter or search the list of recent calls, or use
both methods.

Limit the calls you see in the call history using filtering. Bria 5 lets you filter all calls,
missed calls, calls with recordings, and calls by date.

Searching History
Search for a call in History by either the name of the caller or by their phone number.
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To search History

1. Type the name or phone number for the call your are looking for in Search History.

2. Expand the History entry to find specific call details.

Bria 5 displays all calls from the name or number.

Filtering History
Limit the calls you see in History using filtering. Bria 5 lets you filter all calls, missed
calls, calls with recordings, and calls by date.

Filtering for missed calls

You can filter History for all missed calls or filter for missed calls on a specific account if
you have more than one account.

To filter missed calls

1. Click on the call filter and click Missed Calls.
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2. Click All or click the account you want to see missed calls from if you have more
than one SIP account.

Bria 5 displays all missed calls or the missed calls for the selected account.

Filtering for recordings

If you are searching for a call recording, you can filter the History to show only calls that
have recordings.

To filter for recordings

1. Click on the call filter and click Recordings.

Bria 5 displays all calls that have a recording associated with them.
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Filtering by date

You can search Bria 5 for calls based on when the call occurred. Filter calls from Today,
Yesterday, This Week, This Month, Last 7 Days, and Last 30 Days. This Week filters for
calls for the current week running from Sunday to Saturday. This Month filters for calls
during the current calendar month.

To filter by date

1. Click on the call filter and click Date.

2. Click the selector for the dates you want to filter.

Bria 5 displays all calls that match the date selector.
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To see which filter is applied to call history when the full name of the
filter does not fit, hover over the filter drop down and the full text
appears.

Search and filter History
Use search and filter at the same time. You can filter your results first, and then enter
your search information or enter your search information first and filter your results.

Call recordings in History
Call recording are available in Bria 5's List of recent calls (Windows) or History (Mac) –
referred to as History. You can play and delete recordings from History, in addition to
using the file explorer on your computer to play and delete recording files.

Filtering for recordings
If you are searching for a call recording, you can filter History to show only calls that
have recordings.

To filter for recordings

1. Click on the call filter and click Recordings.

Bria 5 displays all the group that have a recordings associated with them.
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Multiple recordings

If you created multiple recordings of a call – you stopped and restarted a recording during
the same call – all the call recording are visible in the expanded view of the call entry.

Playing back a call recording
You can play back a call recording using either History or using the file explorer on your
computer. This section describes how to play back a call recording using call history. For
more information on call recording, including using the file explorer to listen to a
recording, see Recording a call.

To play back a call recording

1. Optional: Click on the filter and select Recordings.

2. Click on the history group that contains the recording. The history group expands.

CounterPath Corporation 184

Bria 5 User Guide History



3. Click on the call entry that contains the recording. The call entry expands.

4. Click Play Recording.

Bria 5 plays the recording in your default audio player.

Deleting a call recording
You can delete a call recording using History or by locating the file on your computer
and deleting it using file explorer. This section describes how to delete a call in History.

To delete a recording

1. Optional: Click on the filter and select Recordings.

2. Click on the history group that contains the recording. The history group expands.

3. Click on the call entry that contains the recording. The call entry expands.
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4. Click Delete Recording.

5. Click OK on Recording File.

Bria 5 deletes the recording from your computer and you can no longer play back the file
in call history.

The history entry still appears when the Recordings filter is applied. Delete Recording
and Play Recording are still visible in the call entry but are inactive.

Click Recording Info to see when the file was deleted.

Exporting calls from History
You can export your from Bria 5's List of recent calls (Windows) or History (Mac) –
referred to as History – Bria 5 to a .csv file.

To export call history

1. Right-click (Windows) or CTRL+click (Mac) on any group in History and click
Export to File.

2. Use Browse For Folder to set the location where you want to save the file and
click OK.

Bria 5 exports the .csv file to the specified location.
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Deleting History
Calls are grouped by caller ID in Bria 5's List of recent calls (Windows) or History (Mac)
– referred to as History. You can delete all calls in History, or you can delete all calls in a
group.

To delete all calls

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Delete All.

3. Click OK on Confirm Delete.

Bria 5 deletes all calls from History.

To delete a History group

1. Right-click (Windows) or CTRL+click (Mac) on the call group or the heading of the
expanded call group you want to delete.

2. Click Delete.
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Bria 5 deletes the calls in the History group.

Warning: There is no warning before all calls in a group are deleted.
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Microsoft Office Integration – Windows
only

Bria 5 is integrated with Microsoft Office 2013 and Microsoft Office 2016. You can place
an audio or a video call, send an IM, and see presence information directly from
Outlook’s mini-contact card. The mini-contact card appears anywhere you see a contact
— the email header, the Social Connector, the scheduler assistant, the people tab —
when you hover over that contact.

To enable Office integration – Windows only

1. Open Preferences on the Softphone menu.

2. Click Enable Outlook integration in the Application panel.

3. Restart Microsoft Outlook.

Bria 5 is available from Outlook.
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To disable Office integration – Windows only

1. Open Preferences on the Softphone menu.

2. Click Disable Outlook integration in the Application panel.

3. Restart Microsoft Outlook.

Bria 5 is no longer available from Outlook.

Placing an audio or video call from Outlook
You can place an audio or video call from the mini-contact card to an Outlook contact
that you have a phone number or softphone number for.

To place a call

1. Hover over a person’s name anywhere in Outlook. The mini-contact card appears.

2. Click on Call or Start video call.

Bria 5 places the call or video call and opens the call panel. If you clicked Start video
call, Bria 5 opens the Video window if the remote party answers the call with video.

If a contact has more than one number, you can choose the number you want to call.

To place a call to a contact with multiple numbers

l Click the drop-down arrow beside Call or Start video call and select the
number that you want to call.
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Bria 5 places the call or video call and opens the call panel. If you clicked Start video
call, Bria 5 opens the Video window if the remote party answers the call with video.

IM and presence in Outlook
The Outlook Integration offers you the ability to view presence information and send IMs
directly from Microsoft Office.

Sending an IM
There are two ways to send an IM from Outlook: clicking on IM in the message header
and clicking on Send an IM on the mini-contact card.

To send an IM from the message header

1. Click on Send an IM to send an IM to the email sender.

Bria 5 opens the Message window.

2. Type your message and click send.

Bria 5 sends the IM.

To send an IM from the mini-contact card

1. In the header or in the Social Connector, hover over a name or avatar. The mini-
contact card appears.

2. Click Send an IM.

3. If the contact has more than one address you can send an IM to, you can choose
the address you want to use. Click the drop-down arrow beside Send an IM.
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Bria 5 opens the Message window.

4. Type your message and click send.

Bria 5 sends the IM.

To view the online presence of contacts
You can view the online status — the presence — of contacts that have share presence
information with you in Bria 5. Presence is shown in the mini-contact card, beside
avatars, and beside names in the email header.

l On the mini-contact card, presence is indicated by both a colored stripe on the side
of the avatar and by having the status in words under the contacts name.

l On the avatar, presence is indicated by a colored stripe.

l In the email header, a colored dot beside the name displays the status.

Mini-contact card Avatar Name Meaning

This person isAvailable and you can contact this
person.

This person isBusy. You can contact this person.

This person isAway. You can contact this person.

Appearance and Meaning of Presence in Microsoft Office
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Mini-contact card Avatar Name Meaning

This person is on a call. You can contact this
person.

This person haseither set Do not disturb or has
set Not available for calls. You cannot contact
this person.

This person haseither set their statusasAppear
offline or theyare Offline. This contact is either
not logged on or doesnot want to share online
status.
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Configuring Bria 5

This section describes how to manage desktop licenses, perform a silent install, set up
accounts, and preferences on Bria 5.

Managing Bria 5 licenses as an administrator
When you obtain Bria 5, you purchase a license with a specified number of seats. Each
time a user enters the license key, the license count is drawn down on the CounterPath
license database. When the count is drawn down to zero, an error message appears the
next time a license key is entered.

How licenses are counted

A license count can be shared by users on the same computer if the users are logged in
using the Windows administrator account or a regular user account. If a user logs in with
a Windows guest account, Bria 5 will draw down the license count (assuming the
license key has already been entered).

If you have drawn down more license counts than expected, the problem may be that
one or more guests have used seats. You can revoke these licenses in order to reinstate
the number of seats actually in use or you can increase your license count.

To revoke seats on a single group license

1. Log in to the CounterPath store and go to Your Account > Single Group License
Manager. A list of your licenses appears.

2. Click on the license key you want to revoke.

A list of computers with the license appears.
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3. Clear Enabled beside the computer with the license you want to revoke.

The license is now available to use with a different user or different computer.

To revoke seats on an individual license

1. Log in to the CounterPath store and go to Your Account > Individual License
Manager. A list of your licenses appears.

2. Click on the license key you want to revoke and clear Enabled.

The license is now available to use with a different user or different computer.

Setting up the licensing server
Periodically, Bria 5 connects to CounterPath’s license server in order to verify that a
valid license is being used. Therefore, Bria 5 will always need to have an Internet
connection.

Bria 5 connects to https://secure.counterpath.com via port 443; make sure your firewall
allows this HTTPS traffic to this URL. In addition, if you have explicitly set a web proxy,
Bria 5 will use this proxy; make sure the proxy allows this traffic.

Distributing license keys to end users
End users can import and export multiple license keys to Bria 5. As an administrator, you
can create a .csv file with multiple license keys and send the file to end users to activate
Bria 5.

The file format contains the keys separated by a comma:

key1, key2, key3

Direct users to Managing Bria 5 licenses as an end user if they need to import the
license key themselves.
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Performing a silent install of Bria 5

Note: This topic is for network administrators only. Silent installation is available for Windows
only.

For a large-scale installation across many Windows workstations, a network
administrator may want to run the installer as a silent installation — the Bria 5 client
software installs without any user input or interruption.

To run the Bria 5 installer silently, use the following Windows command-line options:

<installer filename>.exe --Silent [--Help] [--AcceptEULA=YES] [--PrintEULA]

where

l --Silent invokes the silent installation mode. All user interaction is suppressed
except the license agreement pop-up, which can be suppressed by also using --

AcceptEULA=YES.

l --Help shows command-line syntax help.

l --AcceptEULA is set to YES to silently accept the license agreement and proceed with
the installation. This option works only when --Silent is used.

l --PrintEULA displays the license agreement on the screen without installing the
software. This option works only when --Silent is used.

For example:

C:\>Bria_5.1.0_12345.exe --Silent --AcceptEULA=YES

This command installs Bria 5 without any user interaction or pop-ups.

Another example:

C:\>Bria_5.1.0_12345.exe --Silent --PrintEULA

This command displays the license agreement but does not install any software. This
might be used in a script to display the EULA first before running the installer again
completely silently.
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Configuring Bria 5 – Accounts
There are two ways of configuring Bria 5 – Account Settings and Preferences.

Account Settings are settings that only apply to an individual account. Preferences are
settings that apply to Bria 5 as a whole.

This section describes Account Settings. Account Settings shows all of the accounts
currently set up. From this window, you can add, edit, enable or disable, or remove
accounts. Click Softphone > Account Settings (Windows) or Bria 5 > Preferences >
Accounts to view Account Settings.

If you have multiple SIP accounts, you can select your preferred SIP account from
Account Settings.

The account types available in Bria 5 are:

l SIP account: A user needs at least one SIP account in order to make phone calls.
If the SIP provider supports SIP SIMPLE, a SIP account can be used for presence
and messaging.

l XMPP account: A user can have an XMPP account for presence and messaging.

l Outlook account (Windows only): A user can pull Outlook contacts into Bria 5
using an Outlook account.

l Mac Address Book account (Mac only): A user can pull Mac Address books into
Bria 5 using a Mac Address Book account.

To view the Account Settings

Windows

1. Click Account Settings on the Softphone menu.

The Account Settings window opens.
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Mac

1. Click Preferences on the Bria 5 menu.

2. Click Accounts.

The Preferences – Accounts window opens.

The Call column

The Call column shows how the account is used for calls.

Windows iconsIcons

: The account is the preferred account for calls

: The account can be used for outgoing calls if you select is when placing an outgoing
call

no icon: The account cannot be used for phone calls. It is either a SIP account with
calling disabled or a non-SIP account.

Mac iconsIcons

: The account is the preferred account for calls
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: The account can be used for outgoing calls if you select is when placing an outgoing
call

: The account cannot be used for phone calls. It is either a SIP account with calling
disabled or a non-SIP account.

The Status column

The Status column indicates the registration status of each account.

Windows Meaning

Ready: The account is registered and can be used for calls (SIP) and messaging.

Registering: The account is in the process of registering.

Failed: The account is enabled but registration failed. Check that you entered your
account credentials correctly.

Disabled: The account is disabled. Select the Enabled check box to register the account.

Mac Meaning

: The account is registered and can be used for calls (SIP) and messaging.

: The account is in the process of registering.

: The account is enabled but registration failed. Check that you entered your account
credentials correctly.

: The account is disabled. Select the Enabled check box to register the account.

Selecting your preferred account for calls
The preferred account for calls in the account that is used if there are no dial plan rules
being used to determine the outgoing account and you do not explicitly choose an
account for the outgoing call.

To select your preferred account

1. Open the Account Settings window.

2. Choose your preferred account from the drop-down list.
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Your preferred account is set.

SIP account
A SIP account is used to make voice and video calls in Bria 5. Each user requires at
least one SIP account. The SIP account can also be used for presence and messaging if
your VoIP service provide supports SIP SIMPLE.

This section describes the SIP account settings. See SIP account requirements to see
how to set up your SIP account.

Accounts or General panel (SIP)

The Accounts (Windows) or General (Mac) panel lets you configure User Details,
Domain Proxy, and the Dial plan for the account.

User ID and Domain are required fields.

Settings in this panel

Account Name

Account Name: Used to identify the account. If desired, change the name to something
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meaningful to you. For example, the name of your VoIP service provider.

Protocol: Read-only. Always specifies SIP.

Allow this account for

Calls (Windows) / Used for Call (Mac): Determines if the account is used to place
outbound calls.

Selected: This account can be used for outbound calls.

Cleared: This account cannot be used for outbound calls.

IM / Presence (Windows) / Presence (Mac): Determines if the account is used for
presence and messaging. Make sure SIP SIMPLE is supported by your VoIP service
provided is you plan to use your SIP account for presence and messaging.

Selected: This account is used to share your online presence and send
instant messages.

Cleared: This account is not used to share your online presence and send
instant messages.

User Details

User ID: The account number for the softphone. Provided by your VoIP service provider.

Domain: The domain of your softphone address. Provided by your VoIP server provider.

Password: The password for the softphone. Provided by your VoIP service provider.

Display name: This is the name that is displayed in the Bria 5 title bar. Remote parties
see this name.

Authorization name: Complete this field if your VoIP service provider gave you an
authorization name. Typically not used in an enterprise environment. An Authorization
name is useful if you allow user IDs that are short and easy to guess. The Authorization
name is used in place of the User ID to register the SIP account.

Domain Proxy

Register with domain and receive calls: This field must be Cleared if your level of
service does not include the ability to receive incoming calls. In this case, leaving this
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field selected may prevent the account from registering.

Selected: Register this account with your VoIP service provider so you can
receive incoming calls.

Cleared: This SIP account cannot be used for incoming calls.

Send outbound via: Choose the settings specified by your VoIP service provider. If you
select this field, complete the Address field with the domain provided by your VoIP
service provider.

Domain: Select this field if your VoIP service provider requires that traffic be
directed to proxies that are discovered via the domain.

Proxy: Select this field if your VoIP service provider has an outbound proxy
address and requires that you provide the address to your softphone client.

If neither of these options are suitable, see Advanced for additional ways to direct traffic.

Dial Plan

Dial Plan: Information about the syntax of the numbers used by your VoIP service
provider. This information is provided by your VoIP service provider.

The default plan is: #1\a\a.T;match=1;prestrip=2;

You do not have to change the dial plan if:

l You only have one SIP account.

l You have multiple SIP accounts but will always manually select the account to use
for calls.

l The default plan is acceptable.

See Using a Dial Plan to Modify How Calls are Placed for information on configuring
dial plans.

Voicemail panel (SIP)

This panel lets you set up client-side voicemail and client-side call forwarding.
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Voicemail is offered through your VoIP service provider or through your enterprise’s IP
PBX. It is not part of Bria 5. Contact your VoIP service provider or your system
administrator for information on using voicemail.

Settings in this panel:

Voicemail

Check for voicemail: Check with your VoIP service provider or your enterprise’s IP PBX
system administrator for the correct configuration.

Selected: Subscribe for message waiting — Bria 5 must subscribe to be
notified when there is a voicemail.

Cleared: Implicit subscription — the VoIP service provider’s voicemail server
send notifications without Bria 5 subscribing.

Cleared: Your VoIP service provider does not support voicemail.

Number to dial for checking voicemail: Complete this field only if your VoIP service
includes voicemail. This is the number that will be called when a user click the Voice
messages icon on Bria 5 to check for voicemail and listen to messages. Completing this
field enables the Voice messages icon. If you leave this field empty, the icon will not
work and you will have to dial your voicemail number manually. Enter the number
provided by your VoIP service provider or system administrator.

Number for sending calls to voicemail: Complete this field only if your VoIP service
includes voicemail. This is the number that incoming calls will be forwarded to if they are
unanswered after the specified interval. This field must be completed if you select Send
call to voicemail if unanswered for. If you leave this field empty, Bria 5 never forwards
call to your service provider’s voicemail. However, most VoIP service providers have
their own mechanism for sending unanswered calls to voicemail. Leaving this field blank
does not mean that forward-to-voicemail does not work. Enter the number provided by
your VoIP service provider or your system administrator.

Send calls to voicemail if unanswered for: Complete this field only if your VoIP service
includes voicemail. Your service provider may have a similar feature outside Bria 5. If
they do, make sure that you are not entering competing information in Bria 5 and in the
service provider’s interface. For example, if you clear this field in Bria 5, make sure that
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you turn this feature off with your service provider as well or calls continue to be
forwarded.

Selected: Bria 5 sends call to voicemail when the specified interval expires.
Enter the time interval in seconds.

Forwarding

Forward to: Forward to only works when Bria 5 is running and only if your VoIP service
provider supports redirect. You can use this feature even if your VoIP service does not
include voicemail.

Selected: All calls will be forwarded to the number specified. Inbound calls
on other SIP accounts (if you have them) are not affected by enabling this
field. Enter the number you want to forward your calls to.

When on the phone, forward to: When on the phone, forward to only works when Bria 5
is running and only if your VoIP service provider supports redirect. You can use this
feature even if your VoIP service does not include voicemail.

Selected: Forward calls only when you are on another call. Inbound calls on
other SIP accounts (if you have them) are not affected by enabling this field.

Your service provider may have a similar feature outside Bria 5. If they do, make sure
that you are not entering competing information in Bria 5 and in the service provider’s
interface. if you clear this field, make sure that you turn this feature off with your service
provider as well.

If you have a subscription from a VoIP service provider

Your VoIP service provider may provide the ability to set up voicemail outside of Bria 5
(server-side handling), such as calling a softphone address and following voice prompts
or by accessing a website.

Check with your VoIP service provider to determine if another setup mechanism is
available. If so, check what settings are in the setup and make sure you enter the
compatible information in Bria 5.

In particular, if your VoIP service provider has a mechanism for call forwarding, find out if
you should leave the Forwarding settings blank.
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If you have a System Administrator managing IP PBX

Your IP PBX may also provide the ability to configure voicemail outside of Bria 5 (server-
side handling). An incoming phone call first goes through server-side handlers and then
through client-side handlers. Keep in mind that the fields on the Voicemail tab are not
written to the server. They are configuring a second, separate handler.

Decide how you want phone calls to be handled — by the Bria 5 client only, by the server
only, or by both the client and the server. Instruct your users accordingly. If you decide to
allow both, make sure that your users understand how the server-side and the client-side
voicemail configuration must be synchronized to work together. Check what the server-
side settings are and make sure you enter compatible information on Bria 5.

Topology panel (SIP)

This panel controls how signals are passed through your network.

Settings in the panel:

Firewall Traversal

Firewall traversal method: Choose the settings recommended by your VoIP service
provider.

Auto-detect firewall traversal method using ICE (Windows) / Auto-detect
(ICE, recommended) (Mac): Automatically determines the contact address
for signaling traffic.

Discover public IP address (STUN): Advertises the public IP address
(discovered via STUN) for the contact address for signaling traffic and for the
connection address for media traffic.

Use media relay (TURN): Advertises the public IP address (discovered via
STUN) for the contact address for signaling traffic.

None: Advertise the local IP address only for both signaling and media traffic.

Server address:

Empty: Discover the address of the firewall traversal server (the STUN or
TURN server), if available, using DNS SRV.
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Specified: Use the firewall traversal server specified as either an IP address
or a fully qualified host name. If you use Auto-detect firewall traversal
method using ICE (Windows) or Auto-detect (ICE, recommended) (Mac),
you can only enter a STUN server here. Do not enter a TURN server
because TURN is not supported when ICE is used.

User name: The user name for the server.

Password: The password for the server.

Port Ranges

Range of ports used for signaling (Windows) / Range of ports used on local computer
(Mac): Set the range of ports on the local computer for SIP signaling.

Selected: Your computer is behind a restrictive firewall that only allows
specific port ranges to be used. Enter the port ranges for your SIP account
and also open the same ports on your firewall. Refer to applicable firewall
documentation for more information.

Cleared: You computer is not behind a restrictive firewall.

Range of ports used for RTP: Set the range of ports on the local computer RTP audio
and RTP video.

Selected: Your computer is behind a restrictive firewall that only allows
specific port ranges to be used. Enter the port ranges for your SIP account
and also open the same ports on your firewall. Refer to applicable firewall
documentation for more information.

Cleared: You computer is not behind a restrictive firewall.

Custom DNS

Server 1 / Server 2: Enter the custom domain name server. A custom DNS is a domain
name server that is specific to a given domain (network or sub-network). It provides Bria
5 the ability to query inside the network for IP addresses associated to domain names
rather than querying outside the domain.
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Presence panel (SIP)

Presence allows other softphone users to see your online status and allows you to see
the online status of others.

This panel lets you configure how your SIP account handles online status for contacts
who have a softphone number. The Presence panel only appears if you have selected
IM / Presence in Allow this account for.

Settings in this panel:

Presence

Mode: Enter the value specified by your VoIP service provider.

Peer-to-peer

Presence agent

Poll time: The frequency, in seconds, that Bria 5 uses to check presence.

Refresh interval: The amount of time, in seconds, that Bria 5 refreshes your presence.

Transport settings (SIP)

You can configure the method Bria 5 uses for transporting your SIP signal.

You can set up Bria 5 for the type of encryption you want for inbound and outbound calls.
Bria 5 supports:

l Signaling encryption using TLS

l Media encryption using SRTP

To set up for security outside of Bria 5

When using TLS (Transport Layer Security), you need to have a root certificate that
signs the proxy’s chain of certificates. In most cases, the root certification will already be
installed. Procedures for the exchange of certificates are outside the scope of this
documentation. The certificates must be stored on the Bria 5 computer in the root
certificate store.

Setting up the root certificate on your computer ensures that the connection to the proxy
is TLS secure (the first hop). Any proxy in the chain between you and the caller that does
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not support TLS may cause an insecure link in the chain. If the other party is outside your
domain, you cannot be completely sure that the call is secured at the signaling level.
This also means that you cannot be sure that it is secured at the media level.

To set up for security in Bria 5

The options for media encryption are set up in the Media Encryption section of the
Transport panel. You only see these settings when Signaling transport is set to TLS.

Settings in this panel

Transport

Signaling transport: Contact your VoIP service provider to identify the types of transport
that are supported.

Automatic: Bria 5 sets up the transport based on the capabilities of the
network and the Bria 5 computer. Choose this option if you do not care which
transport is used.

TCP (Transmission Control Protocol): This transport provides no signaling
security.

UDP (User Datagram Protocol): This transport provides no signaling
security.

TLS (Transport Layer Security): Choose this option to request signaling
encryption or both signaling and media encryption.

Media Encryption (Windows) / Media Encryption over TLS (Mac)

Media Encryption (Windows) / Media Encryption over TLS (Mac): Applies when TLS is
chosen as the Signaling transport method (see Signaling transport above).

Make and accept only encrypted call

Outgoing calls: Bria 5 places all outbound calls with TLS. The call INVITE
will specify SRTP media encryption. If the correct root certificates are not in
place or if the other party does not accept encrypted calls, the call will fail.

Incoming calls: Bria 5 only accepts INVITEs that are for encrypted calls. If
Bria 5 receives a call INVITE that is not encrypted, the call will be rejected.
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Do not allow encrypted calls

Outgoing calls: Bria 5 only places unencrypted calls. If the other party does
not support unencrypted calls, the call will fail.

Incoming calls: Bria 5 only accepts INVITEs that are for unencrypted calls.
Bria 5 only accepts INVITEs that are for unencrypted calls.

Security

Verify TLS Certificate: Applies when TLS is chosen for transport.

Selected: Bria 5 attempts to verify one or more of the certificates sent by the
SIP server to see if they are trusted. If the certificates are trusted by a well-
known certificate authority such as VeriSign, no further action is required. If
the certificates are self-signed, install a corresponding CA certificate on your
device. Contact your VoIP service provider to get a corresponding CA
certificate.

Cleared: Bria 5 accepts the certificate without trying to verify it.

IPv6: Generally, leave this selected. Clear the check box only if advised by your VoIP
service provider or your system administrator.

Selected: Allows Bria 5 to make phone calls and send IMs over an IPv6
network.

Advanced settings (SIP)

The Advanced panel allows you to set registration intervals, timers, the hold method,
and mange connections.

Settings in the panel:

Register Settings

Reregister every: The time interval measured in seconds between Bria 5’s attempts to
reregister in order to refresh the account registration with the account’s VoIP service
provider. A value of zero means that Bria 5 should not attempt to reregister after the
initial registration. This value is placed in the Expires header field of the REGISTER
message.
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Minimum time: If the reregister fails, Bria 5 waits this amount of time, measure in
seconds, and then attempts to reregister. If the second attempt fails, Bria 5 waits twice
this time and tries again. Each time the attempt to reregister fails, Bria 5 increases the
amount of time between tries until registration succeeds.

Timers

Enable session timers: A session timer is a mechanism to detect whether a call session
still active from a signaling point of view. When the timer expires, a refresh is sent from
one party to the other. This timer is then reset.

Selected: Turns on the session timers.

Cleared: Turns off session timers, refreshes will never be sent.

Session time preference: Specifies how Bria 5 uses session timers.

Inactive: Session timers are not used in any session, except when it is
explicitly required in the remote request.

Optional: Session timers are used in all sessions whenever the remote party
supports and uses it.

Required: Session timers support is a requirement for the remote party to be
able to establish a session.

Always: Sessions timers are used in all sessions whether or not the remote
party supports or uses it.

Default session time: The default value of the session timer measured in seconds.

Hold Method

Hold method: Change this setting only if your VoIP service provider advises you to.

Handle hold request in M-line only (latest standard)

Handle hold request in M-line and C-line (old standard)

Connection Management

Send SIP keep-alives: Typically selected. Instructs Bria 5 to send SIP keep-alive
messages in order to maintain a “pinhole” through your firewall for SIP messaging.
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Use rport: Typically selected.

Use SIP Outbound: Determines Bria 5 uses an existing connection.

Selected: Bria 5 uses an existing connections by populating the SIP header
as specific to RFC 5626. The SIP server should communicate with Bria 5
using the same connection if the transport is set to TCP or TLS.

Cleared: Bria 5 does not use an existing connection.

Force outbound proxy on all requests: Typically Cleared. Use this setting only if you
have trouble connecting to the SIP server.

Selected: Requests always go to the outbound proxy configured in Send
outbound via on the Account (Windows) or General (Mac) panel. Bria 5
never sends the invite directly to the end point. If you select this field, make
sure you also set Send outbound via.

Using a dial plan to modify how calls are placed

In Bria 5, a dial plan is a single line of text — an expression — associated with an account
that can modify how your calls are placed. A dial plan is used for any combination of
these reasons:

l To modify (transform) the input (the number to be dialed), such as to add the “9”
required to obtain an outside line from a PBX.

l To select the account to use to place a call, if users can have more than one
account.

l To prevent unresolvable calls from being placed. For example, to prevent using
network bandwidth on a call that will certainly fail. You define patterns that you
know will work, and only place a call if it matches one of these patterns.

If a user has multiple SIP accounts and chooses Auto Select, the dial plan can be used
to select the account to use for outgoing calls. Once the account is selected, the dial plan
can also be used to transform the phone number, for example, to add “9” to the start of
the number.
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If the user selects the account to use when making calls or if the user has only one SIP
account, dial plans can still be used to transform the phone number.

Dial plan examples

These examples demonstrate how a dial plan can be used.

Dial plan 1

This example shows how to differentiate between a PSTN number and
a softphone address, and how to add a “9” dialing prefix only to the
PSTN number.

\a\a.T|xxxxxxx.T;match=2; pre="9"

Pattern Match Transformation Description

\a\a.T 1 (none) The input contains alphanumerics. Call the number without
transformation.

xxxxxxx.T 2 pre="9" If it's a number with at least 7 digits (PSTN), pause and then
dial the number prefixed by9.

Dial plan 2

3xxT|1xxxxxxxxxx|[2-9]xxxxxxxxx|+x.T; match=2; pre="9"; match=3; pre="91";

match=4; prestrip=1;pre="9011"
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Pattern Match Transformation Description

3xxT 1 (none) The first pattern is any three-digit number beginning with3.
No transformation. The assumption is that this is an internal
extension. The timer forcesBria 5 to wait after detecting a
three-digit number beginning with 3, in case you are actually
dialing a local call starting with 3.

1xxxxxxxxxx 2 pre="9" The second pattern is anyeleven-digit number beginning

with1. Prefixwith9and dial as is. The assumption is that
this is a long-distance PSTN callwithin North America

(within North America, all long-distance calls start with1).

[2-
9]xxxxxxxxx

3 pre="91" The third pattern is any ten-digit number beginning with a

number other than1. The assumption is that this is a local
PSTN callwithin a ten-digit dialing zone.9and1are
prefixed to accessan outside line and a long-distance code.

+x.T; 4 prestrip=1
pre="9011"

The fourth pattern is a number of any length that begins

with+, to indicate an internationalPSTN call fromNorth

America. Delete the+and prefixwith9011 (where9
accessesan outside line and011 is the prefix to accessan
international line fromNorth America).

Writing a dial plan expression

Your dial plan instructions (or expression) comes in two sections:

l Patterns - Numbered sequentially, the patterns are things that Bria 5 looks for in
the phone number. If a pattern matches, the pattern number tells Bria 5 to use the
matching transformation of the same number. See Pattern elements.

l Matches/transformations - Each transformation is identified by a "match" number.
See Transformation keywords.

If the phone number matches any of the
patterns...

Bria 5 selects the corresponding match number and performs that
transformation.

Pattern 1 Pattern 2 Pattern 3 … Match &
transformation 1

Match &
transformation 2

Match &
transformation 3

…

Expression syntax

The syntax of your dial plan expression separates each part with semicolons and
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terminates with a semicolon:

pattern;match=n;transformation;

In the above example, there is only one pattern, match, and transformation. You can
have more than one of each in an expression, where patterns are separated by a pipe |
symbol:

pattern1|pattern2|pattern3;match=1;trans1;match=2;trans2;match=3;trans3;

Pattern examples

One pattern

An example of an actual dial plan with only one pattern, match, and
transformation looks like this:

#1\a\a.T;match=1;prestrip=2;

Pattern 1 Match & transformation 1

#1\a\a.T match=1;prestrip=2;

where

l #1\a\a.T is pattern1

l match=1;prestrip=2 is the match1/transformation1 pair

Two patterns

In this example, there are two patterns (separated by a pipe character)
and two match/transformation pairs (indicated by their colors):

#1\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=9;
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Pattern 1 Pattern 2 Match & transformation 1 Match & transformation 2

#1\a\a.T xxxxxxxxxx match=1;prestrip=2 match=2;pre=9

where

l #1\a\a.T is pattern1

l match=1;prestrip=2 is the match1/transformation1 pair

l xxxxxxxxxx is pattern2

l match=2;pre=9 is the match2/transformation2 pair

Pattern elements

The content for a pattern follows the digit map rules of RFC 2705, supplemented by the
rules for regular expressions. Where there is an overlap between the digit map and
regular expression rules, the digit map rules apply. For this reason, there are some
special cases, included in the table below.

Most common elements of a dial plan pattern

All regular expression elements are supported.

Element Element
type

Description

| Regular
expression
rules

Pipe character, used to separate patterns. Example:x.T|xxxxxxxxxx contains two patterns,x.T
andxxxxxxxxxx.

0 1 2 3 4
5 6 7 8 9

Literals Literal digits, used as is. For example, 604xxxxxxxwillmatch with any10-digit phone number that begins
with 604.

# * a to
z

Literals Literal characters, used as is. Special cases:

l The literal x character is represented by\x.

l The literal t character is represented by\t.

x Digit map
rules

Wildcard for any single digit,0 to 9— it matchesanydigit. Example:7xxxwillmatch7100,7232,
7354, or anyother 4-digit number starting with7.

\a Regular
expression

Wildcard for any single alphanumeric character — it matchesanydigit or letter.
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rules

[digit-
digit]

Regular
expression
rules

A digit within the specified range. Example:[2-7]matchesanydigit that is2,3,4,5,6, or 7.

[
character
-
character
]

Regular
expression
rules

A character within the specified range. Example:[b-q]matchesany letter fromb toq.

[digit1,
digit2,
digit3]

Regular
expression
rules

One of the characters in the collection. Example:[2,5,9]matchesanydigit that is2,5or 9.

. Digit map
rules

Repeat the last element 0 or more times. Examples:

l x.means "anydigit followed byanynumber of digits" — in other words, anynumber of any
length.

l \a. means "any letter or digit followed byanynumber of letters or digits.

T Digit map
rules

A timeout period of approximately 4 secondswill take place before automatic dialing starts.

The T timer forcesBria 5 to wait after amatch ismade. This timer should alwaysbe included in these
situations:

l Anypattern that uses the . (dot). For example, if the pattern is xxxx. then adding a timer lets you
type three or more digits. If there is no timer, then as soon as you type three digits, Bria 5makes
thematch.

l Anydial plan that has two patterns that are similar in elements but different in length. For
example, if one pattern is xxxand the other pattern is xxxxxxx, then adding the timer lets you
continue typing past three digits, in order to get amatch on the second pattern.

In this situation, the T timer should be included in the shorter pattern.

Transformation keywords

Bria 5 uses several keywords to transform the input into a number that can be dialed.
These are processed in a specific order.

Keywords

prestrip: Strip the first n characters from the input before placing the call.

poststrip: Remove n number of characters from the end of the input before placing the
call.

pre: Add the specified account prefix to the input before placing the call.
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post: Add the specified postfix to the input before placing the call.

replace: Replace the input with the specified string before placing the call.

Transformation order

These transformations are always performed in the following order (the order in which
the transformations are entered in the dial plan is not significant):

prestrip > poststrip > pre > post > replace

Transformation examples

Dial 9 before the number

Dialing input: 6045551234

Pattern: xxxxxxxxxx

Transformation: pre=9

Dialed number: 96045551234

Use account 2

Dialing input: #26045551234

Pattern: #2x.

Transformation: prestrip=2

Dialed number: 6045551234

Dial local 4-digit extension with a pause in case more
digits are entered

Dialing input: 1701

Pattern: xxxxT
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Transformation: none

Dialed number: (pause) 1701

Dial a New Zealand number that contains the
international "+011" prefix, dial 9 for an outside line, and
include a pause to wait for any additional digits

Dialing input: +642345555555

Pattern: +x.T

Transformation: prestrip=1; pre=9011

Dialed number: (pause) 9011642345555555

Specifying an account by using a prefix

If the input contains an account prefix (# and a digit) and the phone number (for example,
#26045551212), then the prefix is used to select a specific account when calling. The
account prefixed is stripped from the number before the call is placed.

In the example #26045551234, #2 is the account prefix (#1 for the first account in the client's
list of accounts, #2 for the second account, and so on). If the input does not include the #n

prefix, then the Preferred account for calls as set in the client is used.

The Preferred account for calls is identified in Softphone > Account Settings in
Windows and Preferences > Account Settings in Mac.

How Bria 5 uses the dial plan

When the user makes a call, Bria 5 takes the phone number and performs a series of
steps to match the number to a dial plan, alter the number (if necessary), and place the
call.

Dial plan steps

1. Matching.
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When the user finishes typing a number and presses Enter or Call, Bria 5 checks
the user's selection of accounts to determine which accounts to go through.

When Bria 5 is used in Auto Select mode, Bria 5 compares the input to the
patterns in the dial plan for each enabled account. Each account has one dial plan,
and each dial plan has one or more patterns.

When Bria 5 is not used in Auto Select mode, Bria 5 only compares the input to the
patterns in the dial plan for the already selected account. If a match is found, the
transformation associated with the pattern is performed.

2. Transformation.

If a match is found between the input and a pattern, that pattern’s transformation (if
any) is performed.

3. Place Call.

Then the call is placed using the transformed input.

Comparing dialing input to the dial plan patterns

The input is compared to each dial plan in turn, starting with the first listed account. Keep
in mind that the input being compared is different depending on whether the input is
dragged, selected, or typed:

l If the input is dragged or selected, then the entire input is compared to each dial
plan.

l If you are typing the input, then the digits are compared one by one as they are
entered. Each time a new digit is entered, the comparison starts over at the first
account.

Results of the comparison

Bria 5 finds a match according to a number of rules.

Dial plan matching rules and results

Type of Match Result If User Presses Enter or Call Result if User Stops typing

The input matches the
pattern and the
pattern doesnot

Not applicable.

The pattern's account is immediately selected
and the transformation is performedwhen the

This pattern's account is immediately selected. The
transformation is performed. Bria 5 attempts the call.
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include the T timer user stops typing.

The input matches the
pattern and the
pattern includes the T
timer

This pattern’s account is immediately selected.
The transformation is performed. Bria 5
attempts the call.

T starts counting down after each keypress.When T
expires (approximately 4 seconds), this pattern’s account is
selected. Then the transformation is performed and Bria 5
attempts the call.

The input doesnot
match the pattern

TheOutgoing Account is set to Auto Select

Bria 5 uses the account selected as the
Preferred account for calls in Account
Settings. No transformation is performed and
Bria 5 attempts the call.

TheOutgoing Account is set to a specific
account

Bria 5 uses the selected account. No
transformation is performed and Bria 5
attempts tomake the call.

Nothing happensuntil the user pressesEnter or Call.

XMPP account
Setting up an XMPP account is optional. If you set up an XMPP account, it will
automatically be used for presence subscriptions and instant messaging. End users can
pull their XMPP contacts into Bria 5’s contacts and IM these contacts from Bria 5. You
can create and use multiple XMPP accounts.

You create an XMPP account if:

l Your enterprise uses XMPP for presence.

l You already have an XMPP account independent of Bria 5. When the account is
created, the contacts will be pulled into Bria 5’s contact list. You can IM these
contact directly from Bria 5.

General account settings (XMPP)

This panel lets you configure User Details, and signal transport for the XMPP account.

Settings in this panel:

Account name: Used to identify the account. If desired, change the name to something
meaningful to you. For example, the Corporate Account.

Protocol: Read-only. Always specifies XMPP.
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User Details

User ID: The XMPP (Jabber) user ID. Provided by your XMPP service provider. For
example, bhart.

Domain: The domain portion of your XMPP address. Provided by your XMPP service
provider.

Password: The password for your XMPP account. Provided by your XMPP service
provider.

Display name: This is the name that is displayed in the Bria 5. Remote parties see this
name when they are connected to you.

Synchronization

Enable synchronization of messages

Selected: Bria 5 synchronizes XMPP messages between your clients on all
devices.

Cleared: Bria 5 shows messages on the device that they were sent on.

Advanced

Port selection: Configures the port to use.

Auto detected: Bria 5 automatically detects the port to use

User selected: Enter the Connect port.

Connect port: Complete only if Port selection is set to User selected.

Outbound proxy:The value in the User ID and in this setting may be used by Bria 5 to
compose a valid jid (Jabber ID).

If User ID=aphillips@ABC.com and the Outbound proxy is empty, the
jid=User ID: aphillips@ABC.com.

If User ID=aphillips@ABC.com/home and the Outbound proxy is empty, the
jid=User ID: aphillips@ABC.com.
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If User ID=aphillips@ABC.com and the Outbound proxy=XYZ, ignore the
Outbound proxy; the jib=User ID: aphillips@ABC.com.

If User ID=aphillps@ABC.com and the Outbund proxy=IP address or host
address, the jid=User ID: aphillips@ABC.com

If User ID=aphillips and Outbound proxy=ABC.com,
jid=aphillips@ABC.com.

Resource: Optional resource as specified in RFC 3920, for example, home/. If this
setting is blank and the User ID includes a resource, the value from User ID is used. If
both are specified, the value of the Resource is used. If no resource is specified, the
XMPP server will assign a temporary resource.

Priority: The priority as per RFC 3921. The default is zero.

Verify TLS Certificate:

Selected: Bria 5 attempts to verify one or more of the certificates sent by the
XMPP server to see if it is trusted. If the certificate is trusted by a well-known
certificate authority such as VeriSign, no further action is required. If the
certificate is self-signed, install a corresponding CA certificate on your
device. Contact your XMPP service provider to get a corresponding CA
certificate.

Windows Outlook account settings
You can integrate Outlook contacts with Bria 5. Bria 5 offers two ways:

l Using an Outlook account (see below)

l Importing a .pst file

If you integrate Outlook contacts using an Outlook account, the contacts are continually
synced with the contacts in Outlook.

This section describes how to integrate Outlook contacts so they remain in sync.

Outlook account

The user can enable the Outlook account to provide Bria 5 with access to the contacts in
their address book. The users can map contact addresses to fields in Bria 5 in order to
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make calls and send messages to Outlook contacts. Calls and messages can be made
either from Bria 5 or from within Outlook.

Settings in the panel

Account
Protocol: Read only. Always specifies Outlook.

Account Details

Outlook profile: The default Outlook profile detected by Bria 5. If Outlook is set up with
more than one profile and you want to use a different profile other than the default, you
need to change the default profile in Outlook. After you configure the default profile in
Outlook, Bria 5 detects the profile that you have change to.

Field to use for Softphone address: If you are using SIP for presence, you can set up
Bria 5 to treat one of the contact fields in Outlook as a SIP address that can be
subscribed to.

Softphone address example

If you select Business Telephone Number in this field, any values that
are in the Business Telephone Number field in Outlook are copied to
the Softphone field in Bria 5 and Bria 5 subscribes to the online status
of that contact through your SIP account. If an Outlook contact has
“2766” in Outlook’s Business Telephone Number field and your SIP
account domain is “domainA.com”, Bria 5 subscribes to
“2766@domainA.com”.

Field to use for IM address: If you have an XMPP account, you can set up Bria 5 to treat
one of the contact fields in Outlooks as an XMPP address that can be subscribed to.

IM address example

If you select IM Address in this field, any values that are in the IM
Address field in Outlook are copied to the Instant Message field in Bria
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5 and Bria 5 subscribes to the online status of that contact through your
XMPP account. If an Outlook contact has “aphillips@acphone.com” in
Outlook’s IM Address and the domain of your XMPP account is
acphone.com, Bria 5 subscribes to “aphillips@acphone.com”.

Mac Address Book account
Bria 5 creates the Mac Address Book account automatically. To use the Mac Address
Book account, make sure Enabled is selected in the Account Settings window. Once
your Mac Address Book account in enabled, Bria 5 automatically pulls the Mac Address
Book account contacts into Bria 5’s contacts. You can phone or IM them directly from
Bria 5.

To set up for presence

If your Mac Address Book contains phone numbers that you know can be used to obtain
online activity information about the person through your SIP account, you can perform
this additional step.

1. In the Mac Address book make sure that the contact type is Phone and the label is
softphone (in lower case).

2. Enable your Mac Address Book account in Bria 5 > Preferences > Account
Settings. Bria 5 pulls in the contact with the specified number already set up as a
softphone address.

3. Open the contact in Bria 5 and choose the specified phone number in the Primary
Presence field and click OK.

Bria 5 obtains the presence for this contact.

Configuring Bria 5 – Preferences
There are two ways of configuring Bria 5 – Account Settings and Preferences.

Account Settings are settings that only apply to an individual account.
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Preferences are settings that let you control the way that you work in Bria 5.
Preferences also contains fields to configure features that apply globally rather than on
a per-account basis.

This section describes Preferences.

For Windows, click Preferences on the Softphone menu. For Mac, click Preferences
from the Bria 5 menu on the menu bar.

Preferences: Application panel
This panel lets you set preferences for the general user interface.

Login options

Login is typically only used in enterprises and requires a login/provisioning server.

To choose your login options

If you chose I will manually input my account configuration when you started Bria 5 but
you actually do have a login credentials, you can select Enable Sign In screen here.

1. On the Application panel of the Preferences window, select Enable Sign In
screen.

2. Exit Bria 5 by clicking Exit on the Softphone menu (Windows) or by clicking Quit
Bria 5 on the Bria 5 menu on the menu bar (Mac).

3. Launch Bria 5.

The login screen appears. Select the correct option and log in.

Settings in the panel:

General Preferences (Windows)

Language: The language you want the app to run in. Restart Bria 5 for the change to
take effect. Supported languages are English (US), Dutch, French, German, Italian,
Japanese, Portuguese, Russian, Simplified Chinese, and Spanish.

Launch when Windows starts: Determines whether you need to start Bria 5 manually.
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l Selected: Bria 5 Bria 5 launches when you start Windows.

l Cleared: Start Bria 5 manually.

Call immediately once a phone number is selected: Restart Bria 5 for the change to
take effect.

l Selected: You can start a Bria 5 call without click the Make a call button.

l Cleared: You must click the Make a call button to start a call.

Enable Sign In screen: Only available when you selected I will manually input my
account configuration on initial start up. Check if you have login credentials. Restart Bria
5 for the change to take effect.

l Selected: The next time you start Bria 5, you will see the sign in screen.

l Cleared: The next time you start Bria 5, you will not see the sign in screen.

Set Bria 5 as your default softphone: This works for Windows 7 only. See Setting Bria 5
as your default softphone to set Bria 5 as your default softphone in Windows 10.

Enable/Disable Outlook integration: See Office integration.

General Preferences (Mac)

Pause iTunes when making or receiving calls:

l Selected: Bria 5 pauses iTunes when you are using Bria 5 to place and receive
calls.

l Cleared: Bria 5 does not pause iTunes when you are using Bria 5 to place and
receive calls.

Set Bria 5 as your default softphone: Determines whether Bria 5 is your default
softphone.

l Selected: Bria 5 is your default softphone.

l Cleared: Bria 5 is not your default softphone.

Call immediately once a phone number is selected: Restart Bria 5 for the change to
take effect.
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l Selected: You can start a Bria 5 call without click the Make a call button.

l Cleared: You must click the Make a call button to start a call.

Enable Sign In screen: Only available when you selected I will manually input my
account configuration on initial start up. Check if you have login credentials. Restart Bria
5 for the change to take effect.

l Selected: The next time you start Bria 5, you will see the sign in screen.

l Cleared: The next time you start Bria 5, you will not see the sign in screen.

Messages & Presence

Display idle status if I don’t use my computer for:

l Selected: Bria 5 automatically changes your status to Idle if you have not used
your computer for a set amount of time.

l Set the amount of time here. Time is measured in minutes.

In messaging, pressing Enter will: Set the action for pressing ENTER when you are
composing an IM.

l Send the message (Use SHIFT + ENTER to create a line) (Windows)

l Create a new line (Use SHIFT+ ENTER to send) (Windows)

l Send the message (Use CTRL+ ENTER to create a new line) (Mac)

l Create a new line (Use CTRL+ ENTER to send) (Mac)

Show timestamp on messages: Changing this setting affects all messages in your
history.

l Selected: Bria 5 displays date and time information in the message.

l Cleared: Cleared: Bria 5 only displays the message content.

You can always hover over a message to get the date and time information.

Show hyperlink preview on messages: Bria 5 can display a preview for any hyperlinks
that appear in Messages.

CounterPath Corporation 227

Bria 5 User Guide Configuring Bria 5



l Selected: Bria 5 shows a hyperlink preview in the message.

l Cleared: Bria 5 does not show a hyperlink preview in the message.

Messaging Font Face: Use the drop-down box to select a different font for your
messages.

Messaging Font Size: Use the drop-down box to select a font size for your messages.

Default Actions

This section lets you configure the default action for the Call and Transfer buttons and
the action that occurs for double-clicking on a contact.

l You can set the action of the Call button to Call, Make a video call, or Start a
conference.

l You can set the action of the Transfer button to Call First for attended transfers or
Transfer Now for unattended transfer. You can use the drop-down to change the
action of the button on an individual call basis. See Transferring a call.

l You can set the action for double-clicking to Call, IM, or E-mail.

Button: Use the drop-down list to select the button you want to change the default action
for.

l Call

l Transfer

Default Action: Use the drop-down list to set the action that occurs when you single-click
on the Call or Transfer button.

Call button

l Call

l Make a video call

l Start a conference

l Call First

l Transfer Now

Transfer button
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l Call First

l Transfer Now

Action when double-clicking on contact: Use the drop-down list to set the action that
occurs when you double-click on a contact.

l Call

l IM

l E-mail

Security

This section lets you decide what happens when another application requests Bria 5
API access.

When an application requests Bria 5 API access: Select one of the options to determine
how API requests are handled.

l Prompt to all access each time

l Allow access always

l Deny access always

Preferences: Alerts and sounds panel
This panel lets you change the way you are notified of calls, IMs, and messages.

For information on the device that Bria 5 uses for ringing, incoming audio, and incoming
video, see Preferences: Devices panel.

Enabling alerts

You can set up Bria 5 to send an alert in the following events:

l For an incoming call

l When a contact comes online

l When a contact goes offline

l For IMs

l For new mentions in a chat room
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Select Enable alert displays to enable alerts for all the actions. Once Enable alert
displays is selected, you can select which events you want to receive an alert for.

For Windows 10, see Configuring OS notifications to make sure system notifications are
enabled.

Windows

In Windows, you will receive an notification from Bria 5. If you are running Windows 10,
you may receive a Windows 10 interactive toast notification or a Windows 7 style
notification. The Windows 10 interactive toast notification is sent when you select Use
Windows notifications in Preferences > Alerts & Sounds .

Windows 7 style notification

A Bria 5 alert allows you to answer a call, answer a call with video (if the remote party
initiated a video call), or decline a call.

Windows 10 interactive toast notifications

With an interactive toast notification, you can answer or decline the call, or you can
decline the call and send an IM to the remote party. The incoming call notification
displays the name of the remote party and the number they are calling from. If you have
more than one SIP account, the notification also displays the account that the call is
received on.
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Mac

Bria 5 uses OS notifications. Make sure that the notifications are set up for Bria 5 in the
Mac system preferences.

Setting up OS notifications

1. From the menu, click the Apple logo and click System Preferences >
Notifications.

2. Click Bria 5.

3. Choose the banner or alert notification style.

You will receive either a banner or alert notification when you have an incoming call or
instant message on Bria 5. Banner style notifications appear briefly in the top corner of
the screen. They will disappear on their own. Alert styles notifications appear and
remain on the screen until you take action on them.

Banner and alert notifications

If you receive a banner notification, you can click on the notification to open the call
panel or the Messages window.

If you receive an alert style notification for a phone call, you can click Answer or Decline
on the notification or click anywhere else on the notification to open the call panel.

If you receive an alert style notification for an IM, you can click Close or click anywhere
else on the notification to open the Messages window.
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Enabling sounds

You can set Bria 5 up to play a sound in the following events:

l For an incoming call

l For call waiting

l For auto answer

l For hangup

l For an incoming IM

l When mentioned (@) in a Room

l When a contact comes online

l When a contact goes offline

Select Enable sounds to turn on sounds for all the actions. Once Enable sounds is
enabled, you can select whether you would like to hear a sound for each event.

You can assign a sound for each event. Click on the event you want to change the alert
sound for. Use Browse to locate the file you want to use.

For Windows 10, see Configuring OS notifications to make sure system notifications are
enabled.

Settings in the panel

Alerts

Enable alert displays: Determines if Bria 5 displays notifications. Once Enable alert
display is selected, you can select whether you receive an alert For an incoming call,
When a contact comes online, When a contact goes offline, or For IMs (show alert
instead of automatically opening the IM window) by selected or clearing the
corresponding box.

Selected: You can set up alerts for incoming calls, contact presence, and
IMs.

Cleared: Bria 5 flashes in the taskbar (Windows) or the Dock (Mac) for
incoming calls, contact presence changes, and IMs.
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Windows 10 only: Bria 5 sends a Windows 7 style notification or a Windows interactive
toast notification.

Use Windows notifications (Windows only): Determines whether Bria 5 sends Windows
7 style notifications or Windows 10 interactive toast notifications.

Selected: Bria 5 sends Windows 10 interactive toast notifications.

Cleared: Bria 5 sends Windows 7 style notifications.

Sounds

Enable sounds: Determines if Bria 5 plays sounds for notifications. Once Enable Sounds
is selected, you can select whether a sound is played For an incoming call, For call
waiting, For auto answer, For hangup, For an incoming IM, When a contact comes
online or When a contact goes offline by selected or clearing the corresponding box.

Selected: You can set up Bria 5 to play sounds for calls, contact presence,
and messages.

Cleared: Bria 5 flashes in the taskbar (Windows) or the Dock (Mac).

Sound preference: If you have enabled sounds for an event, you can select the
individual event and choose a sound to play for that event.

Click Browse and find the file locations for the sound you want to use.

Click Reset to go back to the default sound.

Preferences: Devices panel
This panel lets you select your Speaker and Microphone in Headset Mode and in
Speakerphone Mode, and lets you select which device should ring, your Camera, and
the maximum resolution for video.

Unless you have made changes in Devices, Bria 5 automatically detects devices at
each startup and selects the most appropriate device for audio and video. Your choices
apply at the next start up unless the device is no longer in use, in which case, Bria 5 will
automatically detect the device to use.

On a new install, Bria 5 uses your system default device for the speaker and the
microphone.
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Test Devices: Opens the Troubleshooting window.

Test Camera: Opens the Video window and shows the image from your camera.

Headset Mode

Change these fields only if you want to override the devices that Bria 5 automatically
selected.

Speaker: Click the drop-down arrow to see the devices detected by Bria 5. Select the
device you want to use for the speaker when you are using a headset.

Microphone: Click the drop-down arrow to see the devices detected by Bria 5. Select the
device you want to use for the microphone when you are using a headset.

Speakerphone Mode

Change these fields only if you want to override the devices that Bria 5 automatically
selected.

Speaker: Click the drop-down arrow to see the devices detected by Bria 5. Select the
device you want to use for the speaker when you are in speakerphone mode.

Microphone: Click the drop-down arrow to see the devices detected by Bria 5. Select the
device you want to use for the microphone when you are in speakerphone mode.

Reduce echoes from speakers (AEC): Automatic echo cancellation.

Selected: Improves the sound quality. The feature is typically on.

Other Devices

Ring on: Change this field only if you want to override the devices that Bria 5
automatically selected.

Click the drop-down arrow to see the devices detected by Bria 5. Select the device
where you want to hear the phone ringing.

Camera: Change this field only if you want to override the devices that Bria 5
automatically selected.

Click the drop-down arrow to see the devices detected by Bria 5. Select the device you
want to use as your video camera.
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Max Resolution: Click the drop-down arrow and select the maximum resolution you
want to user for your outgoing video.

Low (CIF): Common Intermediate Format, uses 352 x 240 pixels.

Medium (VGA): Video graphics array, uses 640 x 480 pixels.

HD (720p): High definition video, uses 1280 x 720 pixels.

HD (1080p): High definition video, uses 1920 X 1080 pixels.

Set to the highest resolution if you have a good camera, a high speed internet
connection, and a computer with a fast CPU. You will know if you have set the resolution
too high if your computer slows down or the video shows black areas or is slow or jerky.

Set to the lowest resolution only in special situations — using Wi-Fi in a hotel. You will
know if you have set the resolution too low if the video is fuzzy.

You can test the resolution by clicking Test Camera once you set this field.

Preferences: Shortcut keys panel (Windows)
Bria 5 supports system-wide shortcut keys and keyboard accelerators. This topic
describes how to enable shortcut keys. For keyboard accelerators, see Bria 5 Desktop
keyboard accelerators.

l Shortcut keys work regardless of whether Bria 5 is in focus or not. Other
applications on your device may interfere with these operations. Bria 5 shortcut
keys are disabled by default until you enable them under Preferences.

l Keyboard accelerators apply only when Bria 5 is in focus. They are keyboard
combinations that speed up common interactions with Bria 5. They cannot be
enabled/disabled, or customized.

Activity Key combination

Answer call CTRL+SHIFT+ALT+A

Hang up call CTRL+SHIFT+ALT+H

System-wide shortcut keys
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Activity Key combination

Focuson Bria 5 CTRL+SHIFT+ALT+F

Togglemute CTRL+SHIFT+ALT+M

Redial CTRL+SHIFT+ALT+R

Dial selected text CTRL+SHIFT+ALT+D

On the Shortcut keys panel of the Preferences window, select Enable shortcut keys to
use the shortcuts in Bria 5. You can also enable or disable individual shortcut keys by
selecting or clearing Enable for each action.

To customize shortcut key combinations

You can change the default shortcut key combinations.

1. Make sure Enable shortcut keys is selected and the action you want to change is
enabled.

2. Select an Action and click Edit. The Edit Shortcut Key window opens.

3. Select the keys that you want to use in the new combination. Select at least two
keys.

4. Type the desired letter or number in the field.

5. Click Assign.

You can use the new shortcut key combination for the action you selected.

Shortcut key combination rules

The following rules apply to shortcut key combinations.

l You cannot override a standard Microsoft Windows combination such as
CTRL+ALT+DELETE.

l The shortcut applies when Bria 5 is running, regardless of the application that is in
focus.

l If another program uses the same shortcut key combination, the application that
was started later has control over that combination.
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l If a shortcut key combination is not valid at a particular moment, entering the
combination has no effect. For example, CTRL+SHIFT+ALT+A has no effect if
there is no incoming call on Bria 5.

Preferences: Audio codecs panel
Codecs are programs in Bria 5 that are involved in transmitting audio and video. Each
codec has different characteristics and each works better in some situations than others.

Codecs can be categorized as either narrowband, wideband, or super-wideband, and
fixed bit rate or variable bit rate.

l Narrowband codecs work with low bandwidth, such as a dial-up Internet
connection. These codecs have a sampling rate of 8 kHz.

l Wideband codecs work with high bandwidth and result in better audio quality.
Wideband codecs do not work with PSTN numbers. These codecs have a
sampling rate of 16 kHz.

l Super-wideband codecs have a sampling rate of 24-48 kHz.

l Fixed bit rate codecs use the same amount of data during the call.

l Variable bit rate codecs use different amounts of data depending on network
conditions.

This panel shows all of the audio codecs that are included in your version of Bria 5. You
can enable and disable codecs by clicking on the codec and clicking one of the arrow
buttons to move it between the Available Codecs column to the Enabled Codecs
column. You can also view the codec properties by clicking on each codec.

With only one codec enabled, all calls will use that codec. With more than one codec
enabled, Bria 5 offers the enabled codecs and negotiates a common codec with the
other party. If you do not have a common codec with the other party, the call will fail.

You cannot change the properties of any codecs.

Enable RFC 7261 negotiation: Without this option selected, Bria 5 responds with G.729
annexb=y to an incoming invite with G.729 annexb=no. If calls negotiated with the G.729
codec fail, select this option.
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Preferences: Video codecs
Codecs are programs in Bria 5 that are involved in transmitting audio and video. Each
codec has different characteristics and each works better in some situations than others.
For example, some codecs require less bandwidth than others but may result in lower
video quality.

This panel shows all of the video codecs that are included in your version of Bria 5. You
can enable and disable codecs by clicking on the codec and clicking one of the arrow
buttons to move it between the Available Codecs column to the Enabled Codecs
column. You can also view the codec properties by clicking on each codec.

With only one codec enabled, all calls will use that codec. With more than one codec
enabled, Bria 5 offers the enabled codecs and negotiates a common codec with the
other party. If you do not have a common codec with the other party, video will not be
available on the call.

Preferences: Directory
If your organization has an LDAP or an Active Directory server, you can configure Bria 5
to connect to that server. The entries from the directory will appear on the Directory tab
beside List of contacts, List of favorites, and List of recent calls.

Typically, directories are only used in enterprises and are set up by a system
administrator. Generally, change these settings only if advised by your system
administrator.

Refreshing of the directory

When data in the LDAP or Active Directory server changes, the Directory in Bria 5 is
refreshed. If Search Options – Search on demand is selected, Bria 5a is refreshed
immediately. If Type to filter list is selected, Bria 5 uses a fetch-and-filter mode and the
directory is refreshed on the next fetch, set in Update interval.

Synchronization between directory and contacts

Users may create contacts from directory entries (see Directory Tab). Whenever the
directory is refreshed, the contact created from the directory is refreshed as well. If the
directory entry is removed from the server, the contact is deleted from the List of contacts
as well.
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Configuring the directory

This panel lets you set up the server settings, the search options, and the mapping of
information from the LDAP or Active Directory server to the directory in Bria 5.

Field Description

Configure Directory

Directory type Select LDAP from the drop-down list

Server Settings (LDAP)

Server The hostname or IP addressof the LDAP server

Example: ldap.example.com

Authentication
method

Anonymous

Simple: Your LDAP server requiresa valid login in order to allow binding and searching the directory.

Username (dn=) The fullDistinguished Name (DN) of the username that will be used for authenticating to the LDAPdirectory.

Credential The password for the Username.

Root DN The “base” DN of the server where searcheswill begin. The entire subtree under the Root DN will be used for
searching.

Example: OU=users, OU=company, DC=example,DC=com

Search
expression

The query used to filter valid users in the directory. This query can only be used to retrieve onlymembersof a
group.

Example: memberOf=CN=Corporate Users, OU=Groups, OU=company, DC=example,DC=com

Server Settings (Active Directory)

Subtree DN The Active Directory subdirectory to restrict the search to.

Search Options

Search on
demand
(requires
pressing Search
button)

The Directory panel of the softphone will have a Search button. The Directory panel is empty until the user
performsa search. Each time the user clicksSearch, a new retrieve is performed. This option is recommended for
directorieswith more than 500 entries.

Type to filter list The Directory panel of the softphone will not have a Search button. The Directory panel is populated with the
records from the LDAPdatabase as soon asBria 5 starts (restricted by theMax results field).When the user types
in the Search Directory field in th Directory tab, the local contents are filtered and a new retrieve is not performed.

Search timeout A search of the database will stop if it hasnot succeeded by this time period, measured in second.

Max results This field is optional.

When Search on demand is selected, this field can be used to prevent the user from retrieving toomany records
and slowing down the system.

When Type to filter list is selected, make sure this number is at least equal to the number of records in your
database. If it is smaller, the recordsat the end of the database will never be retrieved.

CounterPath Corporation 239

Bria 5 User Guide Configuring Bria 5



Enter 0 (zero) if you do not want amaximum number of records.

Update Interval Enabled when Type to filter list is selected.

The database is retrieved at this frequency, measured inminutes.

If the user has filtered the Directory contentswhen the timer expires, the filter is lost and the entire database is
displayed again.

Attribute Mapping

All fields The AttributeMapping panel is used tomap attributes from your LDAPdirectory to corresponding fields in Bria 5.
The panel shows the Bria 5 field that shows in the Contact Profile. Enter the attribute names that are in your
directory.

Example: If your directory storesmobile numbersas the “cell” attribute, enter “cell” in theMobile number field.

Be carefulwith thismapping.When users create a directory entry, Bria 5 will allow or disallow certain functions—
such as sending an IM —based on whether the correct contact method is populated. Specifically:

Softphone: Bria 5 recognizesa value in this field asa softphone addressand willmap this field to the Softphone
contact method. Bria 5 considers a softphone address to be one that can be phoned, and if SIP is being used for
presence andmessaging, one that can be used for presence andmessaging.

Jabber: Bria 5 recognizesa value in the field asa Jabber (XMPP) addressand willmap this to the Instant Message
contact method. Bria 5 considers a Jabber addressasone that can be used for presence andmessaging if XMPP
is being used for presence andmessaging.

Preferences: Calls
This panel allows you to configure auto answer, DTMF, and third party call control
support.

Answer calls

This section allows you to set preferences for the auto answer feature. To enable auto
answer, see Enabling auto answer.

Auto answer after: The time, in seconds, that Bria 5 waits to answer a call when Auto
Answer is enabled. Select the number of seconds from the drop-down list. This field can
be set from 0 (zero) to 5 seconds. Choose 0 if you want Bria 5 to answer calls
immediately. Also pick one of the following:

Auto answer with audio: When Auto Answer is enabled, Bria 5 answers calls
with audio only.

Auto answer with audio and video: When Auto Answer is enabled, Bria 5
answers calls with audio and video.

DTMF

Select a method Bria 5 uses when using dual-tone multi frequency (DTMF) or interactive
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voice response.

You may need to change this method if you cannot interact with interactive voice
response systems — auto attendants, voice-activated menus. Contact your VoIP service
provider or your system administrator for the correct setting.

l Send via RFC 2833

l Send via INFO

l Send in-band

l RFC 2833 and SIP INFO

l In-band and SIP INFO

In-band means that Bria 5 encodes DTMF signals in the audio stream as regular sound.
Typically, DTMF is not send in-band.

You may want to use in-band if all three conditions apply:

l You own your own gateway.

l One or more gateways do not support RFC 2833 or do not handle it well.

l Your gateway is using codes that reproduce DTMF codes well.

In this case, sending in-band ensures your DTMF tones get through because they
bypass the gateway and they are reproduced accurately on the receiving end.

Play DTMF tones back to me

Selected: Bria 5 plays key tones through your speaker when you dial.

Cleared: Bria 5 does not play key tones.

Enable third party call control for

Third party call control is frequently used by Call Center applications in conjunction with
Bria 5. An example of the SIP servers that have this ability is BroadWorks SIP
Extensions.

Answer/resume (talk)

Selected: Enabling this allows Bria 5 to be remotely controlled via a SIP talk
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event, without user intervention, to answer an incoming call and resume a
call that has been previously held.

Hold/resume

Selected: Enabling this allows Bria 5 to be remotely controlled via a SIP hold
event, without user intervention, to place a call on hold and resume a held
call.

Preferences: Files and web tabs
This panel lets you set the locations for call recordings and incoming file transfer, and
lets you add web tabs to the resource panel.

Field Description

File Locations

Recording
folder

Set the location where call recordingsare saved.

Use Browse to find the location in File Manager.

UseOpen Folder to open the current location.

File transfer Set the location where received files are saved.

Use Browse to find the location in File Manager.

Use Open Folder to open the current location.

Web Page Tabs

Set up a web page asa new tab on the resource bar beside List of contacts, List of favorites, and List of recent
calls.

Type the Web address and Name for the website that you want to add. The namewill appear when you hover on
the web icon.

Selected: The tab appears on the resource bar.

Cleared: The tab is removed from the resource bar.

Users can go to View and clickShow Name to hide the website on the resource panel.
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Setting the primary number in an XMPP
vCard

If you have access to XMPP vCard configuration on the XMPP server, you can set a
PREF tag for a specific number to be used as a primary phone number on Bria 5. For
example, if a contact has 3 numbers - home, work and mobile, you can set the work
number as primary by adding a PREF tag in vCard configuration. When end users
double-click the contact, the primary number will be called.

Example

<TEL><PREF/>
<WORK/>
<VOICE/>
<NUMBER>6045551234</NUMBER>

</TEL>
<TEL>

<HOME/>
<VOICE/>
<NUMBER>6045559999</NUMBER>

</TEL>
<TEL>

<CELL/>
<VOICE/>
<NUMBER>7785551234</NUMBER>

</TEL>
...
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Reference

This section provides reference information regarding Bria 5.

Troubleshooting
On the Help menu, click Troubleshooting to display the Troubleshooting window.

Devices panel
You can verify that your microphone and speakers are working and can set the volume
to a comfortable level without having to place a call.

1. Select the microphone and speakers that you want to use from the drop-down
menus.

2. Speak into the microphone. If Bria 5 detects sounds, you see Your microphone
works.

3. Click the Play button while listening to the speakers. Drag the volume slider to set
the volume to a comfortable level. If your speakers are working, you see Your
speakers work.

Audio panel
While you are on a phone call, you can test the quality of the audio.

Note: To perform a valid test, you should be on an established call and not on a call attempt.

Video panel
While you are on a video call, you can test the quality of the video.

Note: To perform a valid test, you should be on an established call and not on a call attempt.
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Support panel
If you have contacted CounterPath Customer Support in order to troubleshoot a problem,
you may have been asked to generate a diagnostic log and send it to CounterPath.

To send a log

1. On the Help menu, click Troubleshooting. The Troubleshooting window opens.

2. On the Support tab, change the log level to Verbose by moving the slider next to
View Log (Windows) or View Current Log (Mac).

3. Close the Troubleshooting window.

4. Reproduce the problem you were having.

5. Return to the Support tab in Help > Troubleshooting.

6. Click Send log. The Send Log Report window opens.

7. Type a brief description of the problem you were having and click Send Log
(Windows) or Send Log Report.

Bria 5 sends the log to CounterPath.

To view a log

1. On the Help menu, click Troubleshooting. The Troubleshooting window opens.

2. On the Support tab, click View Log (Windows) or View Current Log (Mac).

CounterPath displays the reference number of previous logs. You cannot view the
previous logs but the reference number could be helpful when you are talking to
customer support. The customer support representative can view the previous logs and
can use the reference number to find the correct log.

Other ways to use Bria 5
This section describes how to set Bria 5 as your default program, how to run Bria 5 from
a hyperlink, and how to run Bria 5 from the command line.
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Setting Bria 5 as your default softphone
Bria 5 supports three protocols: SIP, TEL, and CALLTO. You can set Bria 5 as the
default app for these three protocols.

To set Bria 5 as your default softphone in Windows 7

1. Click Preferences on the Softphone menu.

2. On the Application panel, click Set Bria 5 as your default softphone app.

3. Select the CALLTO, SIP, and TEL protocols.

4. Click Save.

Bria 5 is set as your default application for the CALLTO, SIP, and TEL protocols.

To set Bria 5 as your default softphone in Windows 10

To set Bria 5 as your default app in Windows 10, you have to go into Windows settings.

1. Open Windows Settings.

2. Click on Apps.

3. Click on Default apps.

4. Scroll to the bottom of the screen and click Set defaults by app.

5. Proceed depending on the screen you see.
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a. Click Bria 5 in the Programs list.

b. Do one of the following:

l To set for all three protocols, click Set this program as default.

l To pick some of the protocols, click Choose defaults for this program.
Select the protocol in the list, and click Save.

a. Click Bria 5 and click Manage.

b. For each protocol, click Choose a default and select Bria 5.

Bria 5 is set as your default applications for the CALLTO, SIP, and/or TEL protocols.

To set Bria 5 as your default softphone – Mac

1. Click Preferences on the Bria 5 menu.

2. On the Application panel, enable Set Application as your default softphone.

Bria 5 is set as your default application for the CALLTO, SIP, and TEL protocols.

Other ways to start Bria 5
Bria 5 can be started from a hyperlink or a Windows command line.

To start Bria 5 from a hyperlink

You can attach a hyperlink to a phone number or a softphone address that start Bria 5
and dials the number when it is clicked. For Bria 5 to start dialing when a user clicks the
hyperlinks, the user must configure Bria 5 as the default phone and associate Bria 5 to
the protocols.

Attach a hyperlink in this format:

<a href="sip:address_or_number">dial address_or_number</a>
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For example:

<a href="sip:aphillips@domainA.com">dial aphillips@domainA.com<a>

To start Bria 5 from the command line – Windows

Note: This is a historical integration. CounterPath does not recommend this for new
integrations. Users with existing integrations should look at moving to the Desktop API.

You can start Bria 5 from a Windows command line. You may need to add the install
directory (typically C:\Program Files (x86)\CounterPath\Bria 5) to the PATH environment
variable in Windows.

To launch Bria 5, type:

bria5.exe

You can also run these action commands:

Bria 5 >bria5.exe -action=<action>=<input>

where action and input are:

Action Input

call?to Enter the remote URI

quit n/a

Examples

Example 1:

C:\>bria5.exe -action=call?to=1331

Example 2:

C:\>bria5.exe - action=call?to=1331@domainA.com
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Bria 5 no longer supports im?to and add?contact. Customers looking to integrate these
features need to use the Desktop API.

Bria 5 Desktop keyboard accelerators
Keyboard accelerators apply only when Bria 5 is in focus. They are keyboard
combinations that speed up common interactions with Bria 5. They cannot be enabled,
disabled, or customized. They are different from system-wide shortcut keys that can be
customized in Windows.

Windows

Making or answering a call

CTRL+N: Answer an incoming call

CTRL+D: Decline an incoming call

CTRL+R: Redial the last number called

CTRL+R then ENTER: Redial the last number called

CTRL+E: End a call or end a conference call (hang up on all participants).

During a call

CTRL+M: Mute your voice

CTRL+H: Hold or resume a call when the focus is on the call panel

CTRL+T: Transfer an established call when the focus is on the call panel

↑ (Up arrow): Turn the call volume up when the focus is on the call panel

↓ Down arrow: Turn the call volume down when the focus is on the call panel

F11: Display the Video window in full screen when the focus is on the Video windows

Opening a window

SHIFT+CTRL+M: pen the Messages window

F8: Open the Preferences window
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CTRL+F9: Open the Support tab in the Troubleshooting window

F1: Open Help in a browser

Exiting

CTRL+Q: Quit Bria 5.

Mac

Making or answering a call

CTRL+N: Answer an incoming call

CTRL+D: Decline an incoming call

CTRL+R: Redial the last number called

CTRL+R then ENTER: Redial the last number called

CTRL+E: End a call or end a conference call (hang up on all participants).

During a call

CTRL+M: Mute your voice

CTRL+H: Hold or resume a call when the focus is on the call panel

CTRL+T: Transfer an established call when the focus is on the call panel

↑ (Up arrow): Turn the call volume up when the focus is on the call panel

↓ (Down arrow): Turn the call volume down when the focus is on the call panel

Opening a window

SHIFT+COMMAND+M: Open the Messages window

COMMAND+,: Open the Preferences window

CTRL+F9: Open the Support tab in the Troubleshooting window

SHIFT+COMMAND+V: Open the Video window

SHIFT+COMMAND+?: Open Help in a browser
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Exiting

COMMAND+Q: Quit Bria 5.

Contact list headings
Following is a list of heading that are used in the Bria 5 contact list. This list can be
useful when formatting a contact list to import into Bria 5.

Heading Description

business_number

business_numbern, where n is 2 to 6

categories Maps to Bria 5 groups

default_address Maps to the Presence field

default_address_com Always specifies IM, if default is specified

Doesnot map to a Contact Profile field

default_address_type SpecifiesSIP or XMPP

display-name

email_address

email_addressn, where n is 2 to 6

fax_number

Fax_numbern, where n is 2 to 6

given_name

home_number

home_numbern, where n is 2 to 6

mobile_number

mobile_numbern, where n is 2 to 6

other_address

other_addressn, where n is 2 to 6

postal_address

presence_subscription TRUEor FALSE

sip_address Maps to the Softphone field
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Heading Description

sip_addressn, where n is 2 to 6

surname

web_page

web_pagen, where n is 2 to 6

xmpp_address Maps to the Instant Message field

Must always specify an XMPPaddress

xmpp_addressn, where n is 2 to 6 Maps to the Instant Message field

Must always specify an XMPPaddress
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Glossary

A

account

In Bria, your account refers to your credentials used to connect with servers. These servers (SIP or XMPP
servers) are used to place calls, send messages, or indicate your presence online.

authentication

Authentication is the process of confirming a user or administrator's identity by way of a username and
password combination (their "credentials").

B

bandwidth

In data transmission, the wider the band, the more data it is possible to transmit in a given time span. A
cable, DSL, and ADSL connection to the network provide broadband for data transmission. A dialup or
ISDN connection typically provide a narrow bandwidth for data transmission.

Bria 5

Bria 5 is a softphone client by CounterPath Corporation. It is available in versions for Windows, macOS,
Android, and iOS.

Bria Desktop

Bria Desktop refers to Bria softphone clients for desktop or laptop computers that run Windows or macOS.

Bria Mobile

Bria Mobile refers to Bria softphone clients for mobile devices that run iOS or Android, such as tablets and
phones.
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C

call display

A service that transmits the caller's information to the recipient. Also known as caller ID.

chat room

A chat room is a persistent session in which two or more people can have a text conversation.

client

In the context of softphones, the client is the end-user device that connects to a server when making a
voice or video call. Bria mobile is an example of a softphone client.

codec

A codec is software that encodes/decodes data, such as audio and video, for transmission and storage.
Each codec has different characteristics, and each works better in some situations than in others.

collaboration conference

A online conference that includes audio, video, screen share, and messaging.

conference

In the context of softphones, a conference is a multi-party voice or video call.

conference host

The individual who initiates a multi-person voice or video call.

credentials

Authentication credentials refer to the username and password combination used to log in.

CSV

Files in Comma-separated Values (CSV) format contain data that's organized by columns and rows, in
which the columns represent data fields and each row represents a record. Values on each row are
separated by a comma.

CTI

Computer-telephony integration. Used in Bria for Salesforce to display the Bria Sidebar
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D

device

A device is a computing device that runs the softphone client, such as Bria 5, and includes computers and
mobile devices alike.

dial plan

In Bria, a single line of text — an expression — associated with an account that can modifies how your calls
are placed. An example might be to modify the dialed number to dial 9 for an outside line.

DNS

DNS (Domain Name System) is a system for converting named addresses into numeric IP addresses.
When given a domain name, a DNS server will return the IP address needed to connect to the domain's
particular server or device on the Internet.

DropBox token

The cloud storage service, DropBox, allows some applications to post files to individual DropBoxes. To do
this, DropBox requires a "token" — a generated string of characters — to authenticate the upload. DropBox
tokens are generated on the DropBox website.

DTMF

Dual-tone multi-frequency. The tones you hear when you press numbers on a phone. Each number
corresponds to a different tone.

E

End User Portal

End User Portal is a web-based service that allows end users to interact with Stretto to manage some of
their own services. Stretto administrators control which functions appear in the End User Portal.

F

firewall

A technology that prevents unauthorized people from connecting to your computer and to the applications
running on your computer.
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H

HTTPS

HTTPS is a protocol for communications over a secure network connection.

hyperlink

A clickable item (words or an image) that links a reader to another document or location.

I

ICE

Interactive Connectivity Establishment. A method for traversing a firewall.

IM

Instant message. A brief text message sent from one person to another with near instantaneous delivery.

ITSP

An Internet Telephony Service Provider (ITSP) is an entity that provides voice-over-IP services.

L

LDAP

LDAP (Lightweight Directory Access Protocol) is a software protocol for interacting with an Active
Directory services database, which can be used for user authentication.

M

MWI

Message Waiting Indicator. An indicator, such as an icon or a light, that shows when a voicemail message
has arrived.

N

notification

A popup, banner, or other message that tells you of an event, such as an incoming call or message. Some
notifications may allow you to respond by clicking an icon or button.
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P

presence

An instant messaging feature that allows uses to share information about their online status.

provisioning

Provisioning involves the process of remotely setting up devices, such as softphones, to use particular
services and resources.

PSTN

Public Switch Telephone Network. The traditional landline telephone network.

R

remote update

Remote update is a process in which a Bria client connects to Stretto to retrieve the latest provisioning
settings. This is not the same as a remote upgrade.

remote upgrade

Remote upgrade is a procedure in which Bria desktop requests a the newer software version, if it's
available. This is not the same as a remote update.

S

SIP

SIP (Session Initiation Protocol) is a software protocol for controlling voice and video communication
sessions. A SIP server manages Bria 5 calls on a network.

SIP account

An account that provides the user with the ability to make VoIP calls. The account encapsulates the rules
and functions the user can access.

SIP SIMPLE

A SIP protocol for presence and instant messaging.
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softphone

A softphone is a software application for making phone calls over the Internet instead of through
dedicated hardware.

softphone address

The address used to connect to a SIP endpoint. The "phone number" used in a VoIP phone call. For
example, sip:joseph@domainA.com.

STUN

Simple Traversal of UDP through a firewall or NAT.

T

toast notification

A Windows 10 popup that informs you of an event, such as an incoming call or message. Windows 10
notifications may allow you to complete an action within the toast notification.

TURN

Traversal Using Relays around NAT. Like STUN, it is a network protocol/packet format (IETF RFC 5766)
used to assist in the discovery of paths between peers on the Internet. It differs from STUN in that it uses a
public intermediary relay to relay packets between peers.

U

USB

Universal Serial Bus. A standard for connecting devices to a computer. In the context of Bria desktop, you
might use a USB headset, camera, or conferencing device.

USB device

A universal serial bus device that follows a specific communications VoIP Voice over Internet Protocol. A
variation of IP used for sending voice data over the internet - making calls over the internet.

V

vCard

An electronic business card that is often attached to an email. If often appears as a signature block that
identifies the person, their title, and their business.
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VoIP service provider

A business that provides a Voice over Internet Protocol (VoIP) service, allowing a user to connect to the
internet in order to make VoIP calls using Bria. The VoIP service provider sets up a SIP account for the
user.

W

Wi-Fi call

A Bria call made over the Wi-Fi Internet. To make a Wi-Fi call, you must be in a Wi-Fi zone.

X

XML

XML (eXtensible Markup Language) is a file format that uses tags to structure data for storage or retrieval.

XMPP

XMPP (or Extensible Messaging and Presence Protocol) is a collection of technologies that support
mesages, chat rooms, voice/video calls, and presence information.

XMPP account

An account that provides the user with the ability to send IMs and view other people's presence.

XMPP Buddy

"Buddy" is the XMPP-specific term for an XMPP chat contact.

Z

zip file

A .zip file is a type of archive file that can contain compressed files and folders.
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